AMS 2600 Machinery Health Expert

A6560R Processor Module and A6510 Signal Input Module
Contents

Chapter 1 AMS 2600 Machinery Health Expert ........................................................................................................... 1
  1.1 AMS 2600 overview .............................................................................................................................................. 1
  1.2 References .......................................................................................................................................................... 1
  1.3 AMS 2600 and accessories .................................................................................................................................. 2
  1.4 Data collection requirements ............................................................................................................................... 3
  1.5 Precautions ........................................................................................................................................................ 3
  1.6 Safety notes ...................................................................................................................................................... 4

Chapter 2 Getting started ............................................................................................................................................... 5
  2.1 Remove the AMS 2600 from the case .................................................................................................................. 5
  2.2 AMS 6500 front view .......................................................................................................................................... 7
  2.3 Back view and connections ................................................................................................................................ 8
  2.4 Turn on the AMS 2600 ....................................................................................................................................... 9
  2.5 Turn off the AMS 2600 ..................................................................................................................................... 9
  2.6 System configuration overview ........................................................................................................................... 10
  2.7 Data collection overview .................................................................................................................................. 10
  2.8 Data recorder modes ........................................................................................................................................ 11
  2.9 AMS 2600 fuse access .................................................................................................................................. 12
  2.10 Access the termination board .......................................................................................................................... 12
  2.11 Connectivity .................................................................................................................................................. 13

Chapter 3 Hardware configuration ....................................................................................................................................... 17
  3.1 Hardware configuration: overview ...................................................................................................................... 17
  3.2 The A6560R and A6510 modules ....................................................................................................................... 18
  3.3 AMS 2600 signal inputs ..................................................................................................................................... 26
  3.4 Configure the A6560R with a terminal emulator ............................................................................................. 27

Chapter 4 Sensor installation ........................................................................................................................................... 32

Chapter 5 Software configuration ....................................................................................................................................... 33
  5.1 System overview diagram .................................................................................................................................. 33
  5.2 System configuration overview .......................................................................................................................... 34
  5.3 Install AMS Machinery Manager ....................................................................................................................... 35
  5.4 Configure the FTP server to download firmware ............................................................................................. 35
  5.5 Connect the A6560R CPU to AMS Machinery Manager ................................................................................... 39

Chapter 6 Data collection and analysis .......................................................................................................................... 40
  6.1 Online database diagram ................................................................................................................................... 40
  6.2 View or edit IP addresses with the unit ............................................................................................................... 42
  6.3 Verify or assign a unit IP address to the Online Server in RBM Network Administration .................................. 43
  6.4 Add a unit's IP address to the Online Server in RBM Network Administration .................................................. 44
  6.5 Online database configuration: overview ......................................................................................................... 44
  6.6 Online Watch overview ................................................................................................................................... 48
  6.7 Archive management ......................................................................................................................................... 51
  6.8 Create an archive manually ............................................................................................................................... 52
  6.9 Disable archive predicates ................................................................................................................................ 52
  6.10 Stop transient acquisition .................................................................................................................................. 53
  6.11 Stop transient acquisition .................................................................................................................................. 53
  6.12 Change databases when moving the AMS 2600 to a new machine ................................................................ 54
## Chapter 7 Specifications

7.1 AMS 6500 Machinery Health™ Monitor specifications .............................................. 55  
7.2 AMS 2600 product specifications .............................................................................. 56  
7.3 Environmental specifications .................................................................................... 56  
7.4 A6560R Processor module LEDs ............................................................................... 57  
7.5 A6510 Signal Input module LEDs ............................................................................... 59

## Chapter 8 System calibration

8.1 System calibration overview ....................................................................................... 61

### Appendices and reference

**Appendix A** Data types ............................................................................................... 64  
A.1 Gross Scan analysis ...................................................................................................... 64  
A.2 Spectral analysis ......................................................................................................... 65  
A.3 Time Waveform analysis .............................................................................................. 66  
A.4 Non-Vibration unit analysis types ............................................................................... 67  
A.5 Set DC offset ............................................................................................................... 67  

**Appendix B** Internal wiring of the AMS 2600 ................................................................ 69  
B.1 Rear termination panel ................................................................................................ 69  
B.2 Internal wiring diagram — AMS 2600 ........................................................................ 72  
B.3 Terminal descriptors ................................................................................................... 73  
B.4 Rear terminal power connections .............................................................................. 76  
B.5 AMS 2600 DIP switch settings ................................................................................... 76

**Appendix C** Troubleshooting ......................................................................................... 77

**Index** ............................................................................................................................. 78
1 AMS 2600 Machinery Health Expert

Topics covered in this chapter:

- AMS 2600 overview
- References
- AMS 2600 and accessories
- Data collection requirements
- Precautions
- Safety notes

1.1 AMS 2600 overview

The AMS 2600 is a portable, online analyzer that simultaneously and continuously monitors and records up to 24 vibration or process channels and up to 4 speed inputs.

The AMS 2600 comes in non-Transient and Transient configurations. This manual describes the AMS 2600 configured as model A2600T8—a Transient, 24 channel system. Available models are:

- A2600M7—non-Transient, 12 channel
- A2600M8—non-Transient, 24 channel
- A2600T7—Transient, 12 channel
- A2600T8—Transient, 24 channel

Emerson’s AMS Machinery Manager allows you to view data collected by the AMS 2600, including orbits, shaft center lines, Bode, polar, cascade, waveform, and spectrum plots live and simultaneously, or to archive for future reference.

The AMS 2600 contains the A6560R CPU module and A6510 Signal Input module.

1.2 References

For instructions regarding the current generation AMS 6500 CPU (A6560R), refer to the following resources:

- MHM-97125-PBF-EN, "AMS 6500 Machinery Health™ Monitor User Guide: A6560R CPU and A6510 Signal Input Module"
- MHM-97124, "AMS 6500 Machinery Health™ Monitor Protection Chassis with A6500-P-RTRM Rear Termination Panel Reference Manual"
- MHM-97402, "AMS Machinery Manager Installation Guide"
- AMS Machinery Manager Help is available from the AMS Machinery Manager menu.
For instructions regarding the previous generation AMS 6500 CPU (A6560), refer to the following resources:

- MHM-97125, Rev 8, "CSI 6500 Machinery Health™ Monitor Hardware Installation Guide"
- MHM-97453, Rev 1, "CSI 2600 Machinery Health™ Expert User Guide"

Refer to the following topics and sources for detailed system setup instructions.

**Table 1-1: Related procedures and topics in AMS Machinery Manager Help**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check the version of AMS Machinery Manager.</td>
<td>Help&gt;Administration</td>
</tr>
<tr>
<td>Add an Online Server.</td>
<td></td>
</tr>
<tr>
<td>Add an AMS 6500 to an Online Server.</td>
<td></td>
</tr>
<tr>
<td>Start and stop data collection.</td>
<td></td>
</tr>
<tr>
<td>Set up data collection for MODBUS data from an AMS 6500.</td>
<td>Help&gt;Data Import</td>
</tr>
<tr>
<td>Using Online Server (O_Server) and Online Watch (O_Watch).</td>
<td>Help&gt;Tools&gt;Online Software</td>
</tr>
<tr>
<td>Set up Acquisition Parameters (APs) for data collection for transient channels.</td>
<td></td>
</tr>
<tr>
<td>Assign a tachometer a transient channel.</td>
<td></td>
</tr>
</tbody>
</table>

**Table 1-2: Related procedures and topics in AMS 6500 Machinery Health™ Monitor User Guide**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set up an FTP Server</td>
<td>Configure the FTP server to download firmware</td>
</tr>
<tr>
<td>Install the firmware</td>
<td>Update CSI Machinery Health Monitor firmware</td>
</tr>
<tr>
<td>Connect to the unit using a serial port or Ethernet</td>
<td>Configure access to a CSI Machinery Health Monitor from a computer</td>
</tr>
<tr>
<td>Deploy the bootscript</td>
<td>Configure boot parameters with a terminal emulator</td>
</tr>
</tbody>
</table>

### 1.3 AMS 2600 and accessories

**AMS 2600 and accessories**

- AMS 2600 and case
- AMS Machinery Manager DVD (contains Firmware)
- AMS Machinery Manager Operating Manuals & Extras DVD
- 1 Ethernet cable
- 1 serial cable
1 package of replacement filters
1 standard IEC 320 C13 to NEMA 5-15P power cord
1 3-pin screw mount connector plug
3-piece international AC adapter kit

Optional accessories
- Sensors
- Mounting pads
- BNC connectors
- Extension cords

Optional firmware
- PeakVue
- Modbus

Optional software
- Object Linking and Embedding for Process Control (OPC)

1.4 Data collection requirements
The AMS 2600 must be connected to the sensors on the equipment you want to monitor and contain an AMS Machinery Manager database that matches the how the sensors on the equipment are connected to the channels of the AMS 2600.

- AMS 2600 and accessories
- Field wiring to installed sensors
- AC line power wiring
- Connection points (usually a buffered output panel) for cabling to the AMS 2600
- Computer (usually a laptop) with AMS Machinery Manager

1.5 Precautions
Cleaning
The AMS 2600 is dust resistant. Use a damp, clean cloth for cleaning. Do not use cleaning fluids, abrasives, or aerosols, as they could enter the device, causing damage, fire or electrical shock.
**Avoid water**

Avoid direct contact with water, wet surfaces, or condensing humidity. Keep away from wet locations such as sinks, laundry, wet basements, swimming pools, and so on. If the device is subjected to these conditions, adverse operation may result. If the surface of the device becomes wet, allow it to dry thoroughly before operation.

**Avoid damage or injury**

Follow these guidelines to avoid costly damage or injury:

- Place the device on a solid, stable surface when not in use and do not place any heavy objects on it.
- Use only accessories recommended by Emerson Process Management.
- Keep liquids and foreign objects away from your AMS 2600.
- Never operate your AMS 2600 if any liquid or foreign object has entered it.
- The enclosure should never be subjected to direct sunlight for long periods of time.

**1.6 Safety notes**

This document is intended as a guide only. No instructions given here are intended to supersede any locally issued directions or safety instructions.

⚠ **WARNING!**

Do not operate the AMS 2600 in a hazardous area.
2 Getting started

Topics covered in this chapter:
- Remove the AMS 2600 from the case
- AMS 6500 front view
- Back view and connections
- Turn on the AMS 2600
- Turn off the AMS 2600
- System configuration overview
- Data collection overview
- Data recorder modes
- AMS 2600 fuse access
- Access the termination board
- Connectivity

2.1 Remove the AMS 2600 from the case

⚠️ CAUTION!

The AMS 2600 should be placed on a dry, level, cool surface where the vents and fans are not blocked. Avoid hot, wet surfaces and do not block the vents or fans.

---

Note

The AMS 2600 cannot be used while in the case.

---

Procedure

Reach down along the top and bottom of the AMS 2600 and extract the device straight up from its case.
Figure 2-1: Remove the AMS 2600 from the case
2.2 AMS 6500 front view

Figure 2-2: AMS 6500 front view with A6560R and A6510 modules

A. Front power switch
B. A6560R Status LEDs
C. A6510 Status LEDs
D. Module name
E. 2 Ethernet ports — NIC and Hub
F. Serial port
G. Handles
2.3 Back view and connections

Figure 2-3: Back view and connections

A. **BNC Connectors** — Sensor channels, CH 1-24; Tach channels TACH 1-4; Digital relay channels, RELAY 1-4.
B. **Thumbscrews** — Access inside of the AMS 2600.
C. **Input power switch** — Turn power on or off to the AMS 2600.
D. **Fuse access panel** — Two 10 A fuses for the power input.
E. **Auxiliary -24 VDC power supply** — Displacement probes can be powered by the auxiliary -24 VDC power supply. The output for this -24 VDC power supply is on the rear of the AMS 2600.
WARNING!

Tachometers should provide 1/rev pulses of >0.5 V pk-pk with tach pulse 2x noise.

The AMS 2600 can accept any sensor type with AC component 10 V pk-pk and DC component < +/-24 V, AC+DC not to exceed +/-24 V. Accelerometers can be powered by the system’s power supply. Enable sensor power using the DIP switches on the termination panel, accessible through the rear panel.

Make sure that the sensor power is disabled when connecting to a protection system with unbuffered BNC outputs.

### 2.4 Turn on the AMS 2600

The AMS 2600 has two toggle switches, and both must be toggled in order to turn the unit on and off.

**Prerequisites**

WARNING!

Ensure that physical contact with unbuffered sensor signals will not interfere with other monitoring or protection systems.

**Procedure**

1. Plug the power cord into a standard 120 - 240 VAC input. Attach one of the provided adapters if necessary.
   
   The unit automatically senses the correct voltage.
2. Press the toggle switch located at the rear of the case to On.
3. Press the toggle switch located at the front of the case to On.

### 2.5 Turn off the AMS 2600

**Prerequisites**

Make sure that the computer has been connected long enough to allow all of the desired data to be transferred to the computer for storage. Check the time stamps of the data being reported in Online Watch. Once the times have progressed past the time range needed, data collection can be stopped and the AMS 2600 can be powered off.

**Procedure**

1. Turn the toggle switch located on the front of the unit to the Off position.

   After a couple seconds, the light will turn off. Wait for the light to turn off before continuing with the next step.
2. Turn the toggle switch located on the back of the unit to the **Off** position.
3. Unplug the power cord.

### 2.6 System configuration overview

The A6560R CPU module communicates through an Ethernet connection. When you are using the AMS 6500, AMS Machinery Manager is on a server and connected through a network. When you are using the AMS 2600, the AMS Machinery Manager is on a laptop and connected directly to the unit.

In order for the unit and the server to successfully communicate, both must have addresses known to each other. Also, A6560R must contain the IP address of the FTP server from which to download firmware updates.

1. Set up the computer:
   - Set the computer’s IP address, as needed.
   - Install AMS Machinery Manager on the computer as a Network system.
   - Set up an FTP server to host the firmware, as needed.
   - Install the A6560R firmware on the FTP server.
2. Set up the unit to communicate with AMS Machinery Manager.
   - Connect the computer to the unit with an Ethernet or Serial cable
   - Connect to the unit from a computer using a terminal emulator.
   - Set the unit’s IP address.
   - Set the IP address of the FTP server for the unit to obtain firmware updates.
3. Connect equipment to be monitored to the unit:
   a. In AMS Machinery Manager, add an online server to RBM Network Administration.
   b. In Online Configuration, add the unit’s IP address, create a database for the equipment to be monitored, and save it to the unit.
4. Set up the database in AMS Machinery Manager:
   a. In AMS Machinery Manager, add an online server to RBM Network Administration.
   b. In Online Configuration, add the unit’s IP address, create a database that matches the configuration of the equipment to be monitored, and save it to the unit.

### 2.7 Data collection overview

The AMS 6500 is a continuously monitoring online systems. Once configured, it will collect both periodic predictive data (Trend, Spectra, and Waveform snapshots, multiplexed two channels at a time) and Transient measurements (continuous unbroken waveforms for
extended periods on up to all 24 channels). Predictive data can be stored in an AMS Machinery Manager database. Sections of the transient waveforms can also be extracted into archives either on-demand or based on alarm events.

For the Transient channels, the waveform measurements are continuously stored on either the internal drive or an external NAS drive (up to 250 GB). When the drive fills up, the system will begin overwriting the oldest measurements in a First In First Out (FIFO) manner.

Data is stored at a rate of approximately 40 MB per hour per channel. The following method can be used for estimating the amount of time that data can be streamed to the HDD before it begins to FIFO. First determine the number of channels that will be commissioned for Transient operation; then use this equation:

\[
\text{Storage Time (in hours)} = \frac{\text{HDD size}}{\text{(number of Transient channels} \times 40 \text{ MB/hr)}}.
\]

For example, consider a pump monitoring system which has a total of 14 sensors. This could include 4 pairs of radial shaft vibration probes, 2 thrust probes, 1 case expansion sensor, 1 eccentricity sensor, and 2 horizontal accelerometers. In addition to collecting periodic prediction data, the 8 shaft vibration probes are also commissioned for Transient data collection.

\[
80,000 \text{ MB} / (8 \text{ channels} \times 40 \text{ MB/hr}) = 250 \text{ hours (approximately 10 days)}
\]

So, the internal HDD will store data for approximately ten days before starting to FIFO.

The AMS 2600 is both a continuous monitoring system and a portable monitoring system. It can be moved from one piece of equipment to another, with data from each piece stored in separate databases. See Section 6.12 for more information.

**CAUTION!**

Changing databases will reinitialize the Transient HDD, which eliminates all stored data. Extract any data before changing databases.

### 2.8 Data recorder modes

#### Data collection to AMS 2600 internal memory

When the AMS 2600 is running and the computer is disconnected, the unit runs in DAT recorder mode, optimized for turbomachinery transient data. Waveforms from up to 24 channels, including tach striping, are recorded continuously and simultaneously. If all 24 channels are streaming transient data, the internal solid-state drive SSD) will store approximately 100 hours of data before it begins to FIFO.

With the computer disconnected, the periodic predictive data is also buffered in the AMS 2600’s internal RAM. The amount of time it will take to fill up the AMS 2600’s internal RAM depends on how periodic predictive data storage settings are configured in the database. This data will also begin to FIFO when the memory buffer is full.
Data extraction from the AMS 2600

If the computer is reconnected while the AMS 2600 is in DAT recorder mode, any buffered periodic predictive data that has not been deleted by the FIFO process will automatically be transferred from internal memory to the database. Transient data will only be written to the database if a transient alarm event has occurred and the associated data has not been deleted by the FIFO process. Each transient channel can transfer a configurable amount of data (up to 30 minutes before and after) when a predefined transient alarm event has occurred.

When the computer is reconnected, portions of recorded data can be extracted on demand with AMS Machinery Manager Vibration Analysis. Field-based processing of multiplexed predictive data continues as usual while Vibration Analysis extracts data.

⚠️ CAUTION!

If the computer is not connected, data may be lost or overwritten.

2.9 AMS 2600 fuse access

⚠️ CAUTION!

Turn off the power and unplug the unit before accessing the fuses.

Two 10 A fuses for the power input are accessible through a small access panel between the receptacle and the power switch. The access panel can be opened with a flathead screwdriver.

Figure 2-4: Fuse access

The AC power input is located on the unit’s faceplate.

A. Fuse access panel

2.10 Access the termination board

⚠️ WARNING!

Always turn off and unplug the AMS 2600 before you open the rear panel. Close the rear panel before powering the AMS 2600.

You can access the termination board through the rear panel of the AMS 2600.
You may need to toggle a DIP switch on the termination board to for enable or disable sensor power.

**Procedure**

1. At the bottom of the rear panel, loosen the thumbscrews by hand.
2. To lock the rear panel in the open position, lift the panel to an almost horizontal position and gently push down near the top center of the panel (as shown).

3. Toggle the DIP switch to the left to turn off sensor power, or to the right to turn it on.

The set of four DIP switches on SW1 controls sensor power for channels 1–4. Sensor power for the subsequent channels is controlled by the DIP switches on SW2, SW3, SW5, SW6, and SW7. *Figure B-1* shows the DIP switches.

**2.11 Connectivity**

The AMS 2600 monitoring unit consists of:

- An AC power connection (110–220 V, 50/60 Hz)
- An Ethernet connection
• Signal connections for 1–24 sensors
• Tachometer connections for 1–4 sensors
• Digital I/O relay connections for 1–4 relays
• System power status LEDs
• An attached cooling fan

2.11.1 Ethernet and serial ports

Use an Ethernet connection to configure the unit or transfer data. Use the NIC port to connect to a computer over a local area network. Use the Hub port to connect directly to the computer.

Use the Serial connection directly from a computer to configure the unit without using the Ethernet port or IP address.

Figure 2-6: Ethernet and serial ports on the A6560R

2.11.2 Power supply

Power input: 120–240 VAC, 50–60 Hz input, auto-sensing.
• AC power connection has an IEC 320 C13 receptacle
• North American 3-prong plug (NEMA 5-15P) is provided
• Unit may be powered with either 110 V / 60 Hz or 220 V / 50 Hz input power
• No internal switches need to be adjusted to select power type
• 80 W consumption

Note
A 500 W UPS is recommended. The quality of the power provided to the AMS 2600 is very important. Although the AMS 2600 contains input protection and some degree of line conditioning, it is important to provide the unit with clean power with ground isolation from the production equipment.
2.11.3 4-channel relay inputs and outputs

The AMS 2600 includes up to 4 I/O relay connections that provide optically isolated digital inputs or dry contact outputs. Inputs can be between 5 V and 24 VDC. Outputs are limited to 24 VDC @ 0.5 A.

The A6510 Signal Input module connects to the unit’s CPU, and allows a combination of sensor and relay types in one module. Each I/O relay channel on the A6510 Signal Input module contains both input and output hardware. The relays are configurable as either input or output relays, with a DIP switch (SW1) on the circuit board. A relay channel that is configured in software cannot be utilized unless the corresponding DIP switch is set to the correct position. The firmware will detect the DIP switch state at startup and generates a flag in the console session if the software configuration does not match the DIP switch setting.

The DIP switches are used to protect a user input device from inadvertently being shorted by a relay output configuration. Set the corresponding DIP switch to the On position for output relays, and to the Off position for input relays. The factory default state of the DIP switches is Off (Input). DIP switch 1 is for the first relay channel and DIP switch 2 is for the second relay channel.

The shelf-state of the output relays is normally open, meaning that when the power to the unit is disconnected, the relays are open. During operation of the unit, the relays are typically closed until activated by an alarm, but they can be configured either way.

The following are usage examples for an online monitoring system:

- (input) Transient event indicator, perhaps from a switch, DCS, external module
- (output) Bad/failed sensor indication
- (output) Alarm level indication
- (output) Speed level indication
- (output) Radial Trip Predicate state
- (output) Axial Thrust Predicate state

In most applications, the AMS 2600 will connect to buffered outputs of a protection system. These modules normally have relay outputs which indicate alarm levels, or bad/failed sensors. However, the AMS 2600 relays are different in that:

- An AMS 2600 alarm relay state may be based upon either overall vibration value (i.e., the attached module) or Analysis parameter signal level (i.e., energy at 1x turning speed, energy at 2x turning speed).
- All, some, or one of the alarm indicators may be mapped to the same AMS 2600 alarm relay output. In other words, all of the “Bad/Failed sensor” signal levels may be internally connected to a single relay. All of the “High alarm” signal levels may be internally connected to a single relay.

Radial Trip and Axial Thrust predicates are special methods of configuring voting logic for relay closures, and are explained in AMS Machinery Manager Help in the Online Software section. These are innovations provided by the AMS 2600 system, which have value in turbo machinery applications.
2.11.4 AMS 2600 field wiring

In addition to predictive monitoring, the AMS 2600 is also a portable transient monitoring system, which means in most applications it is being connected to already installed sensors. Portable transient monitoring is different from a fixed, permanently connected system. For example:

- The portable application includes actions of connecting and disconnecting cables between the AMS 2600 monitoring unit and installed modules or even junction boxes. It is critical to ensure that these actions do not interfere with signals in such a manner that any permanently installed monitoring systems interpret temporary signal fluctuations as trip conditions. This is not a concern when connecting to module buffered outputs.

- Modules may condition the input signal and present a modified version to their own output connections (which are the input connections to the AMS 2600). For instance, some modules connect to an eddy current sensor which provides a DC output equivalent to gap voltage (usually about -10 V) and an AC voltage equivalent to vibration (millivolt signal). These modules are configured or programmed to provide a version of the input signal, at an output connection. The output signal could be a 0 – 10 V version of the input.

An analyst must know the sensitivity and offset of signals connected to the AMS 2600, which may be the same (or different) as signals connected to existing modules. An analyst must also know if the AMS 2600 connections are to buffered or unbuffered field wiring or module outputs.
3 Hardware configuration

Topics covered in this chapter:

- Hardware configuration: overview
- The A6560R and A6510 modules
- AMS 2600 signal inputs
- Configure the A6560R with a terminal emulator

3.1 Hardware configuration: overview

The AMS 6500 Machinery Health™ Monitor (A6560R CPU module, in combination with the A6510 Signal Input module), is a multi-channel, multi-tasking, multi-processor data acquisition system primarily intended for monitoring heavy industrial rotating machinery. Typical signal inputs are dynamic AC machine vibration signatures from accelerometers, velocity probes, or eddy current sensors. These signals include two components: the dynamic AC component, which represents machine vibration, and a DC component, which represents the sensor bias level. In the case of an eddy current sensor, the DC component represents the gap, or average distance between the probe tip and the machine shaft. Other signal inputs include process signals; these are DC parameters such as temperature or pressure.

Tachometer inputs are used to determine machine speed. These tachometer signals are typically generated from an eddy current sensor or passive magnetic sensor positioned at a machine shaft keyway or gear, producing a pulse train (not necessarily 1x machine speed) representing the machine phase and running speed.

Discrete inputs represent machine states such as running, off, and starting. These inputs are used to control or modify the data acquisition based on machine state. Common state control inputs are relay closures or machine RPM. AC or DC signal levels can also be used for state control.

3.1.1 Gross Scan monitoring

Gross Scan monitoring includes:

- the acquisition of the overall level of the dynamic AC vibration signal, typically the RMS value of the signal.
- the DC sensor bias level.
- the measurement of a DC process signal.

All these signal inputs are DC values (the RMS value is a DC value proportional to the overall energy content of the AC signal). The Gross Scan inputs are multiplexed into a fast successive approximation ADC controlled by the A6560R CPU module. Gross Scan monitoring measures all input channels AC+DC twice per second. When the Transient option is included, true waveform peak-to-peak may be included in Gross Scan monitoring.
3.1.2 Spectral Scan

Spectral Scan is defined as the acquisition and analysis of dynamic AC signals only. The signals are acquired, two channels at a time (referred to as CHX and CHY). Preprogrammed groups of Spectral Scan measurement parameters (AP Sets) may be assigned to specific machine state conditions to tailor data acquisition to specific machine operational states.

3.1.3 Transient data capture

Transient data capture is the acquisition of continuous time waveforms of dynamic AC signals. Transient data is captured in parallel for all channels. Other data stored along with the Transient data include Gross Scan data captured once per second, tach pulse records, and acquisition timestamps. The Transient data is stored on hard disk, and is available for real-time analysis via Ethernet.

3.2 The A6560R and A6510 modules

The AMS6500M has an A6560R Processor module and either one or two A6510 Signal Input modules.

The AMS6500T has an A6560R Processor module with a solid-state drive and either one or two A6510 Signal Input modules, each with Transient Filter Boards.

3.2.1 A6560R Processor module

The A6560R Processor module provides all data acquisition, data storage, and data communication functions for the AMS 6500 system and the AMS 2600 system. The A6560R is capable of up to 24 simultaneous, continuous waveform measurements for detailed Spectral analysis, up to 24 RMS and DC values for Gross Scan measurements, up to 4 tachometers for machine speed measurement, and up to 4 digital state inputs.

Gross Scan values, tachometer values, and digital input states may be combined logically to determine machine operating state and define specific data acquisition states. The system can be configured to transmit and store data on either time interval or based on the amount of change of the data values.

The Processor module provides four 100 Base-T Ethernet ports and one RS-232 serial port for system communications and diagnostics. Additional connections are available for the calibration signal and a dry contact SPDT SysFail relay. This relay is energized when the Processor CPU successfully boots. On a CPU failure or power loss, the relay will de-energize.

The Processor module may be configured to download its operational firmware via Ethernet upon boot, or to operate on firmware that has been stored in FLASH memory.

The Processor module has an on-board signal generator capable of producing sinusoidal and DC signals that are routed to the input modules during system calibration and on Power On Self Test (POST).
**Note**
If the unit experiences frequent extreme temperature changes, recalibrate the signal generator more frequently.

The Processor module automatically detects input module type and configuration, and only permits database configuration based on the existing channel set.

**Figure 3-1: A6560R Processor module**
Transient capability

The A6560R CPU module, is capable of parallel, continuous time waveform acquisition on all channels. All collected time waveform data, along with Gross Scan data and up to four tachometer pulse records, is stored on an internal solid-state drive (SSD). The SSD is specially rated for industrial operation and provides approximately 100 hours of DCR (Digital Condition Recorder) transient data. There is also room on the drive to store transient archives manually and automatically.

Transient data can be streamed via Ethernet to analysis applications in near real time, without affecting data collection or on-board data storage.

While collecting time waveforms and tachometer pulses, the processor continuously calculates the peak-to-peak value of each channel's waveform. When configured, this value can be used as the Gross Scan instead of the RMS value produced by the A6510 Signal Input module.

Figure 3-2: A6560R CPU module with and without Transient capability

An A6560RT with mounted SSD. An A6560R next to the older A6560RT.

Replace the Transient SSD

Only replace the Transient SSD if directed by Emerson Product Support.

⚠️ CAUTION!

Follow the same safety precautions as replacing a card in the unit. Always power down the unit.
**Procedure**

Replace the SSD as directed by Emerson Product Support.

**Postrequisites**

Format the Transient SSD.

**Format the Transient SSD**

You must format the new solid-state drive before you can use it.

**Procedure**

1. Power on the system and ignore any hard drive error messages on the HyperTerminal monitor.
2. When the system has booted, launch DHM_III.exe.
   
   DHM_III.exe is located at C:\inetpub\ftproot\bin\Tools directory.
3. In DHM, connect to the unit in "Single User" mode.
4. From the main menu, select Transient > Format Hard Drive.
5. When the drive has been formatted, reboot the unit. Ignore any hard drive error messages.
   
   When the POST process is complete, the firmware automatically prepares the hard drive with the Transient File System. This process can take up to 15 minutes.
6. Disconnect DHM.
   
   The unit will reboot automatically.

When the unit boots, there should be no hard drive error messages. If configured, Transient data collection should begin, indicated by a flashing hard drive indicator on the A6560R CPU module front panel.

**3.2.2 A6510**

The A6510 combines the features of Signal Input, Tachometer Input, and I/O Relays to allow a combination of sensor and relay types in one module.

The A6510 provides 12 channels of vibration or process sensor inputs, 2 channels of tachometer sensor inputs, and 2 optically-isolated I/O relay channels.
Figure 3-3: A6510

Transient Filter Board for the A6510

The Transient Filter Board provides parallel anti-aliasing filters for the signal channels on the Signal Input module. Either one or two Transient Filter Boards may be used to configure either a 12- or 24-channel Transient System.

When installing the Transient Filter Board on the Signal Input module, make sure both mating connectors are fully engaged, then install all six mounting screws.
Vibration signal inputs

The vibration sensor types include accelerometer, passive velocity, active velocity, and displacement. The A6510 Signal Input module will also accept non-specific AC or DC inputs from any source that conforms to the A6560R input range limits.

The vibration inputs provide the following programmable functions for each channel: Input Attenuator /1, /2, Gain x1, x10, integrator on/off. In Table 3-1, the combination of input attenuator and gain setting provide four input range combinations.

Table 3-1: Signal Input module input ranges

<table>
<thead>
<tr>
<th>Attenuator</th>
<th>Gain</th>
<th>Input Range +/-</th>
</tr>
</thead>
<tbody>
<tr>
<td>/2</td>
<td>x1</td>
<td>10.0 V 100 g 100 ips 50 mil</td>
</tr>
<tr>
<td>/1</td>
<td>x1</td>
<td>5.0 V 50 g 50 ips 25 mil</td>
</tr>
</tbody>
</table>
Table 3-1: Signal Input module input ranges (continued)

<table>
<thead>
<tr>
<th>Attenuator</th>
<th>Gain</th>
<th>Input Range +/-</th>
</tr>
</thead>
<tbody>
<tr>
<td>/2</td>
<td>x10</td>
<td>1.0 V&lt;br&gt;10 g&lt;br&gt;50 ips&lt;br&gt;5 mil</td>
</tr>
<tr>
<td>/1</td>
<td>x10</td>
<td>0.5 V&lt;br&gt;5 g&lt;br&gt;5 ips&lt;br&gt;2.5 mil</td>
</tr>
</tbody>
</table>

The integrator allows acceleration signals to be converted to velocity.

The A6510 Signal Input module selects 2 of the 12 vibration channels at a time and routes them to the Processor module for spectral analysis. The RMS and DC signals are routed to the Processor module for Gross Scan collection.

The Transient Filter Board is required for Transient data acquisition.

To measure 4-20 mA signals, add a resistor across the channel input. A typical value is 250 ohms, which converts 4-20 mA to 1-5 V. Maximum series resistor value is 1000 ohms.

**Tachometer inputs**

The Tachometer inputs allow measurement of two pulse tachometer sources per module. Tachometer sensor types may include, but are not limited to: eddy current sensor, Hall effect sensor, or TTL pulse type from various sources.

The Tachometer Input module features either fixed voltage trigger or “adaptive” automatic triggering. Triggering parameters may be set independently for each tachometer sensor input.

An input gain selection of x1 or x5 may be selected for each channel. A gain of x5 is recommended for tachometer inputs smaller than 1 V pk-pk. If the x5 input gain is used, care should be taken to make sure that the input signal remains within +/-24 V, including any sensor bias or gap voltage.

**I/O relay channels**

Each A6510 Signal Input module has two I/O relay channels that provide optically isolated discrete inputs or dry contact outputs. Inputs can be between 5 V and 24 VDC. Outputs are limited to 24 VDC @ 0.5 A.

**Note**

AC relays are not provided.
Each I/O Relay channel on the A6510 Signal Input module contains both input and output hardware. The relays are configurable as either input or output relays, with a DIP switch (SW) on the circuit board. A relay channel that is configured in software cannot be used unless the corresponding DIP switch is set to the correct position. The firmware will detect the DIP switch state at startup and generates a flag in the Telnet session if the software configuration does not match the DIP switch setting. The DIP switches are used to protect a user input device from inadvertently being shorted by a relay output configuration.

Set the corresponding DIP switch to the ON position for output relays, and to the OFF position for input relays. The factory default state of the DIP switches is OFF (Input). DIP switch 1 is for the first relay channel and DIP switch 2 is for the second relay channel.

The shelf-state of the output relays is normally open, meaning that when the power to the unit is disconnected, the relays are open. While operating the unit, the relays are typically closed until activated by an alarm, but they can be configured either way.
3.2.3 Install or remove a module

**WARNING!**

Turn off power before installing or removing prediction cards. Prediction cards are NOT hot swappable.

**Procedure**

- Install a module:
  1. Line up the guide rails and push the module into the slot until fully seated.
  2. Tighten the mounting screws.

- Remove a module:
  1. Loosen the mounting screws.
  2. Push outward on the handles to eject the module from the backplane connectors.
  3. Pull the module out of the slot by the handle.

![Figure 3-6: Install or remove a module](Image)

*Use the handles to install or remove modules.*

3.3 AMS 2600 signal inputs

The AMS 2600 is designed to receive voltage signals directly from sensors or from sensor support modules. The online database will store the collected sensor signal in the appropriate engineering unit, such as acceleration, velocity, displacement, and pressure. Signals from 4-20 mA devices, RTDs, thermocouples, and other specialized sensors require
external conditioning electronics that convert the sensor signal into a voltage signal the AMS 2600 can accept on its BNC input panel. The AMS 2600 can supply power to piezoelectric sensors from the BNC connection.

The AMS 2600 has 4 BNCs for tachometer inputs on the rear panel. The tachometer BNC inputs accept voltage signals only and do not furnish tachometer power.

When the AMS 2600 is in transient data collection mode, not all signals connected to an AMS 2600 need to be designated as transient. But since the Transient system is used to detect unexpected events using its continuous monitoring capability, it’s best to designate every channel to be transient to make sure a special event is not missed.

3.4 Configure the A6560R with a terminal emulator

3.4.1 Configure a serial port connection from a computer

Use a terminal emulator such as Telnet or HyperTerminal to connect to the AMS Machinery Health Monitor using a serial cable or an Ethernet cable.\(^{(1)}\) Configure the settings in Table 3-2 in the terminal emulator’s connection settings.

**Prerequisites**

You need a username and password to log on to a AMS Machinery Health Monitor with Telnet.

<table>
<thead>
<tr>
<th>Table 3-2: Serial port connection setup</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Setting</strong></td>
</tr>
<tr>
<td>serial port</td>
</tr>
<tr>
<td>baud rate</td>
</tr>
<tr>
<td>data bits</td>
</tr>
<tr>
<td>stop bit</td>
</tr>
<tr>
<td>parity</td>
</tr>
<tr>
<td>flow control</td>
</tr>
</tbody>
</table>

3.4.2 Configure A6560R boot parameters with a terminal emulator

During normal usage, it is unlikely that you will need to change the initial boot parameters. However, you may need to change boot settings in two situations:

- If you replace the processor module. You may replace an A6560 with an A6560R.

(1) Telnet and HyperTerminal are Windows Features that are available but are not enabled by default. You can use other terminal emulator programs.
• The unit is added to an existing Ethernet network that is not directly connected to the online server through a dedicated cable.

**Note**
Do not add a unit to an existing network until its processor board IP addresses have been verified and changed, if necessary, to be compatible with addresses already in use on the existing network.

**Procedure**

1. Start a terminal session, and turn the unit on.

A screen similar to the following will appear during the boot process:

```
VxWorks System Boot
Copyright 1984-2016 Wind River Systems, Inc.
CPU: Freescale P1010E — Sty Engine
Version: VxWorks 6.9
BSP version: 6.9/5.00g
Creation date: Jul 18 2016 09:26:09
Press any key to stop auto-boot...
```

2. When the boot process has completed, type `bootChange` and press Enter to configure the unit. This command is case-sensitive.

**Important**
If a gateway is used on the network, the address must be specified as a boot parameter.

A list of boot parameters appears one line at a time. When configuring the A6560R, the screen will look similar to this:

```
boot device : motetsec0
processor number : 0
host name : host
file name : bin/6500R
inet on ethernet (e) : 192.168.0.10:ffffff00
inet on backplane (b) :
host inet (h) : 192.168.0.1
gateway inet (g)* :
user (u) : anonymous
ftp password (pw) (blank = use rsh) :
flags (f) : 0x1008
target name (tn) :
```
CAUTION!

Only change boot flags under the direction of Emerson Product Support.

If allowed to complete without interruption, the boot process should finish with a screen similar to this:

<table>
<thead>
<tr>
<th>Cfg Table</th>
<th>Last &quot;Put&quot; Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>DIO</td>
<td>2008-08-13 19:09:25</td>
</tr>
<tr>
<td>GS</td>
<td>2008-08-13 19:09:25</td>
</tr>
<tr>
<td>TACH</td>
<td>2008-08-13 19:09:25</td>
</tr>
<tr>
<td>SCHED</td>
<td>2008-08-13 19:09:26</td>
</tr>
<tr>
<td>PRED</td>
<td>2008-08-13 19:09:25</td>
</tr>
<tr>
<td>LIMIT</td>
<td>2008-08-13 19:09:26</td>
</tr>
<tr>
<td>TRANS</td>
<td>2008-08-13 19:09:29</td>
</tr>
<tr>
<td>EGU_FAC</td>
<td>Default Table</td>
</tr>
<tr>
<td>EGU ASN</td>
<td>Default Table</td>
</tr>
</tbody>
</table>

BRS_initRamdisk_i32f: No browser disk image found in FLASH
Initializing empty browser RAM disk /browser...Succeeded.

/browser/ - Volume is OK
Base Modbus register table size (excluding DCS info): 0xcf8a (53130)
This unit will begin announcing its availability in 84 seconds

0x7942148 (t_startup): HLTMON_sysCheck_i32f: All expected modules were successfully registered

3.4.3 Console session navigation after boot interrupt

You may interrupt the boot process by immediately pressing Space after the VxWorks copyright is displayed. If you interrupt the boot process, use the following commands to navigate the boot configuration menu.

The most commonly used commands are ?, @, p, and c.

Note
When modifying an entry, type the new setting. Do not attempt to backspace over an existing entry.
CAUTION!

Use only the first four commands (?, @, p, c) in Table 3-3 to navigate in a console session. Contact Emerson Product Support before using any other commands.

VxWorks commands are case-sensitive.

Table 3-3: Console session navigation after boot interrupt

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>?</td>
<td>Print this list</td>
</tr>
<tr>
<td>@</td>
<td>Continue boot (load and go)</td>
</tr>
<tr>
<td>p</td>
<td>Print boot parameters</td>
</tr>
<tr>
<td>c</td>
<td>Change boot parameters</td>
</tr>
<tr>
<td>e</td>
<td>Print fatal exception</td>
</tr>
<tr>
<td>v</td>
<td>Print version</td>
</tr>
<tr>
<td>M</td>
<td>Change MAC address</td>
</tr>
</tbody>
</table>

3.4.4 Console session navigation after boot complete

After typing bootChange in a console session, use the following commands to navigate:

**Note**

When modifying an entry, type the new setting. Do not attempt to backspace over an existing entry.

VxWorks commands are case-sensitive.

Table 3-4: Console session navigation commands

<table>
<thead>
<tr>
<th>Key sequence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>Accept the value.</td>
</tr>
<tr>
<td>. (period)</td>
<td>Clear the value when you press the period key followed by Enter.</td>
</tr>
<tr>
<td>– (dash)</td>
<td>Go back to the previous parameter when you press dash followed by Enter.</td>
</tr>
<tr>
<td>safeReboot_vf</td>
<td>Reboot the system with new boot settings.</td>
</tr>
</tbody>
</table>

3.4.5 Boot flags

For the A6560R, you can list boot flags by typing a question mark (?) into a console session at the VxWorks boot prompt.

Boot flags below are expressed in hexadecimal. To activate more than one boot flag at the same time, add them together using the Windows Calculator. Select View > Programmer, and select the Hex radio button.
### Table 3-5: Complete list of boot flags

<table>
<thead>
<tr>
<th>Boot Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x0002</td>
<td>Load local system symbols (for debug).</td>
</tr>
<tr>
<td>0x0004</td>
<td>Don’t autoboot (for testing).</td>
</tr>
<tr>
<td>0x0008</td>
<td>Quick autoboot (no countdown).</td>
</tr>
<tr>
<td>0x0040</td>
<td>Use DHCP to get IP address parameters (not recommended).</td>
</tr>
<tr>
<td>0x0080</td>
<td>Use TFTP to get boot image (network boot only).</td>
</tr>
<tr>
<td>0x0200</td>
<td>Ignore BOOTROM update image in FLASH (for testing).</td>
</tr>
<tr>
<td>0x1000</td>
<td>Attempt network, fallback on FLASH boot (legacy 4500 mode).</td>
</tr>
<tr>
<td>0x2000</td>
<td>Boot ALWAYS from network, never fallback on FLASH.</td>
</tr>
<tr>
<td>0x4000</td>
<td>Boot ONCE from network. This flag clears itself after one boot.</td>
</tr>
</tbody>
</table>
| 0x8000    | Boot over a WAN, requiring extended FTP timeouts. This flag applies only if one of the following flags is set:  
|           | • 0x1000  
|           | • 0x2000  
|           | • 0x4000 |

### 3.4.6 Subnet masks

A subnet mask is normally represented as a series of four decimal numbers, each of which can have a value from 0 to 255, separated by periods (255.255.255.0).

In the system boot parameters, the subnet mask is represented as a series of four hexadecimal pairs with no separators (that is, 255.255.248.0 is represented as fffff800). A hexadecimal conversion table can be used to convert the subnet mask numbers from decimal to hexadecimal. The calculator in the Windows Accessories folder will also perform this conversion when it is set to Programmer Mode.

**Specify a subnet mask**

The subnet mask on an A6560R Processor module defaults to 255.255.255.0 (fffff00).

**Procedure**

1. The subnet mask should be set to match the subnet mask used on the server computer or laptop.
   
   If they do not match, network communication failure is possible.

2. Subnet mask is applied on the IP address of the system boot parameter inet on ethernet. Enter the IP address of the unit followed by a colon and then the subnet mask in the hexadecimal format.
4 Sensor installation

Ensure sensors are installed according to instructions provided by the sensor manufacturer and industry best practices.
5 Software configuration

Topics covered in this chapter:

- System overview diagram
- System configuration overview
- Install AMS Machinery Manager
- Configure the FTP server to download firmware
- Connect the A6560R CPU to AMS Machinery Manager

5.1 System overview diagram

Figure 5-1: System overview diagram

- Network Server—Service responsible for handling the user’s access to the various programs within the AMS Machinery Manager software.
- Online Watch (O_Watch)—Graphic interface that allows:
  - viewing of data sent to the server by the A6560R CPU module
  - management of transient acquisition and auto-extraction
  - adjustment of alarm levels
  - on-demand data acquisition
Online Configuration (O_Config)—Program that allows the creation and modifying of databases for use with the online system, along with system commissioning.

Vibration Analysis (Diagnostics)—Application that allows the user to request and save transient data and view live streaming data. It provides a variety of analysis functions necessary for analyzing the data generated by the AMS 6500 or AMS 2600.

CSImmDbMgr Service—Handles most of the reading and writing operations performed on databases stored on the server. It also indexes and verifies the integrity of databases.

Online Server (O_Server)—The central process service which handles all predictive activity on the online system. It is responsible for processing requests from the client, sending configuration information to the AMS 6500 or AMS 2600.

MHM Remote—Service that handles transient data generated by the AMS 6500 or AMS 2600, and database access required by the Vibration Analysis program.

AMS 6500 or AMS 2600 — Hardware portion of the monitoring system. The AMS 6500 is a fixed installation of the monitoring unit and the AMS 2600 is a portable unit that is connected to the server through Ethernet. Both the AMS 6500 and AMS 2600 use the A6560R with A6510 modules.

IIS FTP—Microsoft’s IIS includes an FTP server which needs to be installed to allow the A6560R to load firmware from the server.

Firmware—The firmware for the A6560R is loaded from the computer when the unit powers on. This allows system updates to be installed on the computer like any other program update without the requirement of any special interaction with the A6560R beyond rebooting it to allow the new version to load.

5.2 System configuration overview

The A6560R CPU module communicates through an Ethernet connection. When you are using the AMS 6500, AMS Machinery Manager is on a server and connected through a network. When you are using the AMS 2600, the AMS Machinery Manager is on a laptop and connected directly to the unit.

In order for the unit and the server to successfully communicate, both must have addresses known to each other. Also, A6560R must contain the IP address of the FTP server from which to download firmware updates.

1. Set up the computer:
   - Set the computer’s IP address, as needed.
   - Install AMS Machinery Manager on the computer as a Network system.
   - Set up an FTP server to host the firmware, as needed.
   - Install the A6560R firmware on the FTP server.

2. Set up the unit to communicate with AMS Machinery Manager.
   - Connect the computer to the unit with an Ethernet or Serial cable
   - Connect to the unit from a computer using a terminal emulator.
   - Set the unit’s IP address.
3. Connect equipment to be monitored to the unit:
   a. In AMS Machinery Manager, add an online server to RBM Network Administration.
   b. In Online Configuration, add the unit's IP address, create a database for the equipment to be monitored, and save it to the unit.

4. Set up the database in AMS Machinery Manager:
   a. In AMS Machinery Manager, add an online server to RBM Network Administration.
   b. In Online Configuration, add the unit's IP address, create a database that matches the configuration of the equipment to be monitored, and save it to the unit.

5.3 Install AMS Machinery Manager

Install AMS Machinery Manager on your computer with the following options checked:

- Network Server
- Online Server
- AMS Machinery Manager Client

Refer to your software user guide for these details.

5.4 Configure the FTP server to download firmware

Each time a AMS Machinery Health Monitor powers up, it checks for firmware on the FTP server. If it finds firmware, it compares the version with the firmware stored in internal flash memory. If the versions are different, the version on the server is downloaded to the AMS Machinery Health Monitor.

Unless otherwise specified, AMS Machinery Health Monitor systems are pre-configured and set up during commissioning.

The FTP server must be configured on a computer on the network so that a AMS Machinery Health Monitor can obtain firmware updates. If an FTP site is not available, the AMS Machinery Health Monitor boots from the firmware stored in memory. The FTP service is available but not enabled by default on Microsoft Windows. Refer to your Microsoft Windows Operating System instructions to enable the FTP web server and set up an FTP site. These instructions are an overview of the steps to configure an FTP Server for the AMS Machinery Health Monitor firmware on the Windows operating system.
Prerequisites

Install AMS Machinery Health Monitor firmware on the computer where you will configure the FTP service. The default location for the firmware on the FTP server is C:\inetpub\ftp\root\bin\. 

Procedure

1. Enable an FTP server in Internet Information Services (IIS)

   The Windows’ built-in web service is called Internet Information Services (IIS).

2. Complete the steps and configure the settings to match the FTP settings on the AMS Machinery Health Monitor according to the following example.

Table 5-1: AMS Machinery Health Monitor FTP configuration

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site name</td>
<td>The FTP site name to display in IIS Manager. This is for your reference.</td>
</tr>
<tr>
<td>Physical path</td>
<td>The path to the bin directory where the firmware will be installed on the FTP server (do not include the bin directory). C:\inetpub\ftp\root, for example.</td>
</tr>
<tr>
<td>Binding</td>
<td>Set Binding to All Unassigned or the IP address or a range of IP addresses assigned to this computer. Do NOT enable virtual host names.</td>
</tr>
<tr>
<td>Start FTP site</td>
<td>Allow the site to start automatically. Check Start FTP site automatically.</td>
</tr>
<tr>
<td>Security</td>
<td>On Windows 7, choose Allow SSL and do not select a certificate. On Windows 8 and Windows 10, choose No SSL.</td>
</tr>
<tr>
<td>Authentication</td>
<td>Choose Anonymous if the AMS Machinery Health Monitor’s user (u) and password (pw) boot parameters are set to anonymous.</td>
</tr>
<tr>
<td>Authorization</td>
<td>Choose Anonymous users if the AMS Machinery Health Monitor’s user (u) and password (pw) boot parameters are set to anonymous.</td>
</tr>
<tr>
<td>Permissions</td>
<td>Read</td>
</tr>
<tr>
<td>Port</td>
<td>21</td>
</tr>
</tbody>
</table>

Table 5-2: AMS Machinery Health Monitor FTP settings

<table>
<thead>
<tr>
<th>Boot parameter</th>
<th>Definition</th>
<th>Default settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>host inet (h)</td>
<td>The IP address of the FTP server</td>
<td>192.168.0.1</td>
</tr>
<tr>
<td>user (u)</td>
<td>The username for the FTP account</td>
<td>anonymous</td>
</tr>
<tr>
<td>ftp password (pw)</td>
<td>The password for the FTP user</td>
<td>anonymous</td>
</tr>
</tbody>
</table>

The FTP site name appears in the Connections pane and the site is started.
5.4.1 AMS Machinery Health Monitor firmware update

Emerson Process Management periodically releases updates to firmware. When you update your AMS Machinery Manager software, it is a good practice to update the firmware if a new version is available. Refer to the Readme file (Readme.rtf) on the Software Installation DVD for information about the current firmware version. These instructions apply to the following AMS Machinery Health Monitor systems:

- AMS 6500 Machinery Health Monitor
- AMS 2600 Machinery Health Expert
- CSI 4500 Machinery Health Monitor

Install the firmware on the FTP server

Prerequisites

You need the AMS Machinery Manager Software Installation DVD.

Procedure

1. Log on to the computer that hosts the FTP Server for your AMS Machinery Health Monitor.
2. Insert the AMS Machinery Manager Software Installation DVD.
3. Open the DVD in Windows Explorer and browse to Install/Online Firmware.
4. Double-click setup.exe and continue through the installation.

   **Important**
   On Windows 7, right click setup.exe and select Run as administrator.

5. Accept the license agreement.
6. Select the type of installation.
   - Select Typical to install the firmware and tools.
   - Select Custom to choose to install either the firmware or the tools.
7. Follow instructions presented by the installation program.

   The online firmware is installed in C:\inetpub\ftproot\bin\.

Postrequisites

Cycle the power on each AMS Machinery Health Monitor that uses this FTP server.

Reboot the AMS Machinery Health Monitor

Cycle power on the AMS Machinery Health Monitor and verify the system is in good status after it boots.
Procedure

1. Cycle the power on each AMS Machinery Health Monitor that needs to get the new firmware update from the FTP server.
2. Wait approximately 5 minutes for the system to complete the boot process.
3. Verify the system is powered on and in good status.

Refer to the Installation Manual for your specific hardware model for more information.

Check the firmware version in AMS Machinery Manager

1. Log on to AMS Machinery Manager Client with the Administrator user account or a user that has permission to use online technology.
2. Go to Tools > Setup/Communications > Online Configuration.

The Online Config window appears.

3. Go to File > Online Server > Open.

The Select Online Server Host Computer dialog appears.

4. Choose a server name from the menu and click OK.

The Online Server opens and a tree structure appears in the left pane of the Online Config window.

5. In the tree structure, expand Units folder, and right-click the icon next to the AMS Machinery Health Monitor you want to check and select Properties.

The Unit Properties screen appears in the right pane and displays the State, Firmware Revision, DSP Revision, Total RAM, and Unit Type.

Figure 5-2: Unit properties

6. In the Unit Properties pane, verify State is Node (Unit) Up and Firmware Revision matches the version you installed.
Contact Product Support for help if the firmware version does NOT match.

5.5 Connect the A6560R CPU to AMS Machinery Manager

The A6560R CPU must be connected to AMS Machinery Manager through an Ethernet connection to transfer data for storage or analysis. Both the unit and the computer must be configured with an IP address in the same logical network.

Procedure

- To connect to AMS Machinery Manager on a laptop, connect a standard Ethernet cable (included) from the unit's Hub port to the computer.
- To connect to AMS Machinery Manager network server on a Local Area Network, connect a standard Ethernet cable from your network to the unit's NIC port.

5.5.1 IP addresses for network configuration

IP addresses are unique addresses that systems on a network use to communicate with each other.

Table 5-3: Example IP addresses

<table>
<thead>
<tr>
<th>A6560R CPU module</th>
<th>192.168.0.10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>192.168.0.1</td>
</tr>
</tbody>
</table>

Notes

- The IP addresses shown are defaults. If two or more A6560R will be used, each should be given a unique IP address.
- Depending on the computer network IP addresses, subnet masks may be required. Transient extraction may fail without them. See Specify a subnet mask.

In short, the A6560R must “know” its server address, and the computer must “know” the IP address of any A6560R.

5.5.2 Set the computer's IP address

Follow your operating system's instructions for changing the computer's IP address before connecting a laptop to an AMS 2600.

Procedure

1. Make a note of your computer's current settings.
2. Change the IP address assigned to the computer Ethernet port to the address expected by the AMS 2600.
6 Data collection and analysis

Topics covered in this chapter:

- Online database diagram
- View or edit IP addresses with the unit
- Verify or assign a unit IP address to the Online Server in RBM Network Administration
- Add a unit's IP address to the Online Server in RBM Network Administration
- Online database configuration: overview
- Online Watch overview
- Archive management
- Create an archive manually
- Disable archive predicates
- Stop transient acquisition
- Remove an archive from the Transient Archive Status tab
- Change databases when moving the AMS 2600 to a new machine

6.1 Online database diagram

The structure of an online database is designed to mirror the structure of the equipment being monitored. Figure 6-1 shows the relationships of the elements of an online database to the equipment being monitored.
6.1.1 Collection criteria

Analysis Parameter (AP) Set

Defines a particular way to collect spectral and waveform data, and specifies:

- the number of lines of resolution.
- any averaging modes and windowing.
- whether to be order-based or frequency-based.
- what FMax to use.
- what parameters are to be collected.

Alarm Limits (AL) Set

Each AL Set is associated with a specific AP Set. You may define multiple AL Sets for any given AP Set to accommodate changing monitoring conditions. The alarm limit definition determines when alarms occur, data is stored, and output relays are set.

Predicate

A collection predicate is an expression that compares the conditions of vibration levels, input relay states, or machine speeds to determine when data is collected and Transient auto-archives are extracted.

6.1.2 Logical hierarchy

Area

A user-defined grouping of equipment. An area often corresponds to a building or section of a process line within a plant.
Equipment  A group of coupled devices that logically should be monitored together. Most often a machine train is made up of a driver component (such as a motor) and one or more driven components (such as a pump or fan).

Component  A specific, single asset to be monitored. Motors, engines, turbines, pumps, and fans are examples of components.

Measurement Point  Corresponds to a single physical sensor. A Measurement Point groups together all the data from all the collections that have been defined for a particular sensor. Any Gross Scan data collected on the sensor and reported for storage is logically associated with the Measurement Point in the database.

Data Collection Set (DCS)  The DCS is a single collection of data on a single Measurement Point. Multiple DCSs allow multiple collections on a single Measurement Point. The DCS combines a particular predicate (when to collect), with a particular AP Set (what and how to collect, including parameter bands), and a specific AL Set (alarm set points).

### 6.1.3 Physical hierarchy

- **Machinery Monitor (unit)**  The physical monitoring unit.
- **Signal Channels**  An AC vibration or DC process input.
- **Tachometer Channels**  A speed measurement input.
- **Digital I/O Channels**  A discrete relay, Input or Output.

### 6.2 View or edit IP addresses with the unit

Verify the network addresses of the computer, the unit, and the database.

**Procedure**

1. Start a terminal session on the AMS Machinery Health Monitor.
   
   If you use a serial connection with PuTTy or HyperTerminal, you do not need a username and password.

   If you use a Telnet connection, log in with the following credentials. Both are case-sensitive:
   - username: csi
   - password: csiSupport

2. At the prompt, type `bootChange` and press **Enter**. This command is case-sensitive.
   
   A list of boot parameters appears one line at a time.

3. Press **Enter** to advance down the list of parameters.

4. Note the IP addresses in the following fields:
The value in inet on ethernet is the IP address of the A6560R CPU module.

The value in host inet is the IP address of the computer where the FTP server has the unit's firmware installed.

5. On your computer, view the IP address of the FTP server by following Windows' instructions for viewing IP addresses. Verify that this address matches the one shown in host inet.

### 6.3 Verify or assign a unit IP address to the Online Server in RBM Network Administration

The online database must have the IP addresses of assigned monitoring units.

**Procedure**

1. Log in to AMS Machinery Manager and click on RBM Network Administration.
2. In the RBMadmin window, double-click the server listed under the Online Server panel.
3. In the Online Server Setup window, the Active Units panel lists the IP addresses of units available for the online server.
   
   If the system is configured to store data in a database, a database will be displayed in the Machinery Health Manager Database frame, the two Edit buttons will be inactive, and the Stop Data Collection button will be inactive.

4. If necessary, assign the IP address of an AMS 6500 or AMS 2600 to Active Units.
   
   a. In the Online Server Setup window, click Stop Data Collection.
   b. Beside the Active Units panel, click Edit.
   c. In the Edit Online Server’s Active Unit List window, type the IP address of an AMS 6500 or AMS 2600 in the New Unit field.
   d. Click Add New.
      
      The IP address appears in the Active Units panel.
   e. Click OK.
      
      The Edit Online Server’s Active Unit List window will close.
   f. In the Online Server Setup window, click Start Data Collection.

Once an AMS 6500 or AMS 2600 IP address is listed in RBM Network Administration, that address may be used for any existing or future database built with the online server. This task does not need to be performed each time a new database is built.
6.4 Add a unit's IP address to the Online Server in RBM Network Administration

Prerequisites

Add an online server in RBM Network Administration.

The unit must have an IP address in the same network as that of the online server.

Procedure

1. In RBM Network Administration, select Online Server > Online Server Setup.
   The Online Server Setup window appears.
2. Select a server name from the Online Server menu.
   The Online Server box displays the AMS Machinery Manager database assigned to the selected Online Server. Active Units lists the AMS Machinery Health Monitors monitored by the selected Online Server.
3. If data is being collected, click Stop Data Collection.
   Data collection must be stopped to make changes.
   The Edit buttons become active.
4. Click Edit beside the Active Units box.
   A New Unit field appears.
5. Type in the IP address in New Unit and click Add New.
   The unit appears in the Active Units list.

6.5 Online database configuration: overview

Configuring a database for an online monitoring application includes understanding how each sensor is attached to the equipment and the corresponding connection to the AMS 6500 or AMS 2600.

In most cases, a AMS 2600 is not connected directly to sensors. Rather, it is connected through coax cable with BNC connectors to a panel of monitoring modules. These modules are connected to field wiring. Therefore, when building a database, it is important to have a diagram that shows what sensors are connected to which monitoring modules. In addition, an analyst who builds an online database needs to know if the monitoring modules perform any signal conditioning on the input signals before passing them through to their output connectors.
The AMS 2600 has the capability to provide bias voltage and current (+24 V / 4 mA) for accelerometers and must be in this configuration if connecting directly to accelerometers. However, if connecting to a module, it is likely that the module powers/biases the accelerometers and sensor power should not be turned on at each AMS 2600 signal connection.

6.5.1 Database configuration pre-requisites

Have the following information available before you begin to build a database:

- Sensors connected to each channel; sensitivity, offset (eddy current sensors, thrust probes), signal range.
- Source of sensor power for accelerometers.
- Definition of the transient event (speed drops below 3585 RPM, input relay from external control system changes state, etc.)
- Sensors for which transient measurements are desired.
- IP address of each system.
- Bearing clearances (radial eddy current sensors).
- Resting DC voltage measurements for radially mounted eddy current sensors.

6.5.2 Collection predicates

Predicates are conditions that have a value of True or False, and are used to guide measurement operations.

A Collection Predicate tells the system when to perform a routine data collection based upon the definition created in the database. Inputs into this type of predicate include:

- speed
- Gross Scan AC amplitude
- Gross Scan DC amplitude
- discreet input signal
- another predicate

An example of a Collection Predicate for a transient operation would be “Speed below 3585 RPM”. This predicate will have a value of False if speed is above 3585 RPM. It would have a value of True if speed is below 3585 RPM.

6.5.3 Create a collection predicate

Use Online Configuration to create a collection predicate.

In AMS Machinery Manager, open Online Configuration and connect to the Online Server. The database is collecting data.
**Procedure**

1. In the tree structure in the left panel, expand Units, expand the AMS 6500 that will collect data, right-click the Predicates folder, and select Add Collection Predicate.

2. Enter a name for the predicate. Do not include spaces.

3. Click the Tach drop-down menu and select the tachometer to be used for acquisition.

   This will be a tachometer connected to Tach location 1, 2, 3, or 4.

   The Tach Clause dialog opens.

4. Click the Comparison drop-down menu and select an equation for the predicate.

5. Enter an RPM value in the Speed1 field.

6. Click OK.

7. Click Apply to finish.

---

**6.5.4 Configure a database for transient operation**

The online system may be used to simultaneously monitor machinery under normal operating conditions and to create a large archive of information for those signals designated (while building the database) as transient. All sensor connections to the unit are configured for predictive operation. Some (or all) of these are also designated as transient and are configured for transient operation.

**Procedure**

1. Create collection predicate for transient auto-archive operation.

   When you create an auto-archive definition, this collection predicate will cause the unit to automatically transfer an archive of transient measurements to the online server, where they can be viewed by an analyst. Archives stored on the transient hard drive will eventually be written over by new measurements.

2. Configure the Measurement Points to associate tach channels with vibration channels.

   a. In Online Configuration, right-click Areas, select Add Area.

   b. Enter an Abbreviation and Description, and click Apply.

   c. Right-click the newly created Area and select Add Equipment.

   d. Enter an Abbreviation and Description, and click Apply.

   e. Right-click the newly created Equipment and select Add Component.

   f. Enter an Abbreviation and Description, and click Apply.

   g. Right-click the newly created Component and select Add Measurement Pt.

   h. Enter an Abbreviation and Description, and click Apply.

   i. With Component Properties still open, click the Monitoring Unit tab.
In the Online Monitoring Unit field, click Attach.

Select the unit and click Okay.

In the Component Properties field, click Apply.


Transient channels may be commissioned all at once, unlike prediction channels. An analyst may designate some or all of the already commissioned predictive channels for transient operation. Some signals, such as case expansion may not include valuable transient information. In this case, they do not need to be commissioned as transient—only as predictive signals.

a. In the Online Configuration tree structure, right-click on the unit and select Commission Transient Channels.

The Commission Transient Channels dialog appears, showing signals already commissioned for predictive operation.

b. Select the desired tach channel, and click the check box for each signal input you want to associate with the tach channel.

c. Click the Acquire button.

Measurements for the entire set of signals are shown.

d. Click Commission to commission the channels for transient operation.
Data collection starts when you save the configuration to the O_server, which also downloads it to the unit.

4. Create an Auto-Archive definition.

This tells the unit when to automatically send an archive of measurements to the online server.

a. Right-click the Transient Tachometer and select Transient Auto-Archive Properties.

The Auto-Archive Properties dialog appears.

b. Set the Pre-trigger time (in minutes) and Post-trigger time (in minutes).

Pre-trigger time indicates how long the auto-archive will take measurements before the collection predicate changes to TRUE. Post-trigger time indicates how long the auto-archive will take measurements after the collection predicate changes to TRUE.

After all measurements have been collected, the archive will be sent from the unit to the online server.

6.5.5 Review and save a transient database

After creating a database, create a report to review your database configuration. The report includes:

• firmware revision used by the unit
• calibration information for the unit
• predicates and their definitions
• signal connections, transient or predictive
• tachometer definitions
• relay definitions

Procedure

1. In the Online Configuration tree structure, right-click on the unit and select Report.
2. Select File > Online Server > Save.

The database configuration is downloaded to the unit.

6.6 Online Watch overview

AMS Machinery Manager Online Watch monitors system status and views the latest measurements.

To open Online Watch, log in to AMS Machinery Manager, click the Tools tab, and in the left panel, click Analysis.

Online Watch can perform four specific transient operations:
• Create archives manually.
• Disable archive predicates.
• Stop and start transient streaming.
• Remove archives from the Transient Archive Status tab.

Transient system status includes:

• Streaming/not streaming to HDD
• Time of oldest recorded information
• Progress of archive creation

The Online Watch screen displays the system status, and the status of any archives. This display has two tabs, Transient Status and Transient Archive Status.

Transient archives are stored under the server folder ...\CustData. Two items will be created in this folder. One is the actual online database file, with an .rbm extension. The other is a sub-folder with the same name as the online database. Inside this sub-folder is a collection of other folders, including one named archives. Transient archives are stored under this archives folder, with a separate folder for each archive.

6.6.1 Online Watch—Transient Status tab

Figure 6-3: Online Watch—Transient Status
### Table 6-1: Transient Status tab fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Node(Unit)Up</td>
<td>Unit is ready to monitor using the database definition.</td>
</tr>
<tr>
<td></td>
<td>Acknowledged</td>
<td>Unit is reorganizing internal software and schedules to conform to the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>database definition.</td>
</tr>
<tr>
<td>Current Acquisition State</td>
<td>Transient Acquisition has</td>
<td>Transient measurement is proceeding normally.</td>
</tr>
<tr>
<td></td>
<td>started</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Transient Acquisition has</td>
<td>Transient measurement was manually stopped.</td>
</tr>
<tr>
<td></td>
<td>stopped</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Unknown</td>
<td>Temporary message after a database is downloaded.</td>
</tr>
<tr>
<td>Active Streaming Location</td>
<td>Primary</td>
<td>Transient system is recording to the primary drive, as specified in Online</td>
</tr>
<tr>
<td>(1)</td>
<td></td>
<td>Configuration &gt; Unit Properties.</td>
</tr>
<tr>
<td></td>
<td>Failover</td>
<td>Transient system has detected a problem with the primary drive and is</td>
</tr>
<tr>
<td></td>
<td></td>
<td>recording to a Failover drive, as specified in Online Configuration &gt; Unit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Properties.</td>
</tr>
<tr>
<td>Transient Drive Details</td>
<td>Oldest Data</td>
<td>Date and time of the oldest measurements currently stored in the unit.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Update this field by clicking Refresh.</td>
</tr>
<tr>
<td></td>
<td>Newest Data</td>
<td>Date and time of the newest measurements currently stored in the unit.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Update this field by clicking Refresh.</td>
</tr>
<tr>
<td>Storage Location</td>
<td>Primary</td>
<td>Path displays which drive—Internal, External, No Path—has been specified</td>
</tr>
<tr>
<td>Configuration</td>
<td></td>
<td>as the primary streaming location. Size displays how much memory is</td>
</tr>
<tr>
<td></td>
<td>Failover</td>
<td>Path displays which drive—Internal, External, No Path—has been specified</td>
</tr>
<tr>
<td></td>
<td></td>
<td>as the secondary streaming location. Size displays how much memory is</td>
</tr>
<tr>
<td></td>
<td></td>
<td>available.</td>
</tr>
<tr>
<td>Auto-Archive Status</td>
<td>Tach #</td>
<td>Tachometer input associated with a group of transient vibration channels.</td>
</tr>
<tr>
<td></td>
<td>Speed</td>
<td>Current speed measured by the Tach input.</td>
</tr>
<tr>
<td></td>
<td>Predicate</td>
<td>Name of the predicate used for triggering the auto-archive.</td>
</tr>
<tr>
<td></td>
<td>Last Report</td>
<td>Date and time of the most recent archive.</td>
</tr>
<tr>
<td></td>
<td>State</td>
<td>True means the parameters of the auto-archive predicate are being met and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>data is being recorded to the drive. An analyst can select the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Transient Archive Status tab to monitor the progress of archive creation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>False means the parameters of the auto-archive predicate are not being</td>
</tr>
<tr>
<td></td>
<td></td>
<td>met and data is not being recorded.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Disabled means the automatic archive predicate has been disabled.</td>
</tr>
</tbody>
</table>

(1) The Active Streaming Location is where transient data is recorded during normal/constant system operation. Measurements from this drive are extracted when an archive is created, and sent as a folder (archive to the online server).

### 6.6.2 Online Watch—Transient Archive Status tab

The Transient Archive Status tab shows archives that are currently being created.
Table 6-2: Transient Archive Status fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component</td>
<td>(variable)</td>
<td>Displays the machine component associated with the transient archive group.</td>
</tr>
<tr>
<td>Archive Name</td>
<td>(variable)</td>
<td>Displays the name of the archive that was specified in Online Configuration. Range 1500_2985 indicates that the collection predicate is TRUE for speeds between 1500 and 2985 RPM. The number in <em>0</em>_ is reserved to ensure the filename is always unique. 05–30–2007 indicates the date the archive was created, in mm-dd-yyyy format. 10 .17 .07 indicates the time the archive was created, in hh.mm.ss format.</td>
</tr>
<tr>
<td>Archive Status</td>
<td>Pending</td>
<td>The system is waiting for post-trigger data to be collected, before sending that data to the database.</td>
</tr>
<tr>
<td></td>
<td>Archiving</td>
<td>The system is sending a complete set of measurements to the online server.</td>
</tr>
<tr>
<td></td>
<td>Complete</td>
<td>All measurements have been sent to the online server.</td>
</tr>
<tr>
<td>Archive Type</td>
<td>Predicate - parameters</td>
<td>The archive was initiated by a predicate.</td>
</tr>
<tr>
<td></td>
<td>Manual</td>
<td>The archive was initiated on-demand by a user.</td>
</tr>
<tr>
<td>Percent Complete</td>
<td>00.00%–100.00%</td>
<td>Displays progress while the system sends measurements to the online server.</td>
</tr>
</tbody>
</table>

6.7 Archive management

Archives are stored in folders in C:\RBMnet\RBMsuite\CustData. Computers have a finite amount of video display memory that may limit the amount of graphic data viewed in an archive. To achieve efficient system operation, an analyst should regularly review extracted archives and keep only those of interest or only the portions of interest in each archive. An analyst can extract smaller archives from large ones using the program Vibration Analysis. To extract and view large amounts of information, an analyst should sequentially extract individual archives of 1 - 2 hours of measurements.
6.8 Create an archive manually

There are three major differences between manually created archives and automatically created archives:

- Manual archives only include information already stored in the A6560R. Automatically-generated archives can include information which is received after the transient collection predicate = TRUE.
- Manual archives do not automatically have a date-time stamp appended to them. You can assign each archive a unique name.
- Manual archives can specify a custom length of time. Automatically generated archives have a maximum of 60 minutes of measurements.

Procedure

1. In Online Watch, select a component that has transient signals.
2. Right-click and select Start Transient Archive.
3. Define the manual archive characteristics.

Postrequisites

Observe the progress of manual archives in the Transient Archive Status tab.

6.9 Disable archive predicates

An analyst can disable the creation of automatic archives during startup or when the machine is being cycled and multiple archives are not desired.

Procedure

1. In the Transient Status tab, right-click on the archive predicate and select Disable Archive Predicate.
   
   A caution window appears.

2. Click Okay to confirm disabling.

The predicate State on the Transient Status tab reads Disabled.

To re-enable the archive, right-click on the archive predicate and select Enable Archive Predicate.

Example: Archive creation

When an archive predicate changes from DISABLED to TRUE, no archive is created. Consider the following sequence:

1. Archive predicate is false.
2. Archive predicate is disabled prior to machinery start-up.
3. Machine starts up and increases to a speed of 1800 RPM.
4. Archive predicate is re-enabled.
5. Archive predicate immediately changes to value of TRUE.
6. No archive is created.
7. Machine speed continues to rise and reaches a speed of 3000 RPM.
8. Archive predicate changes to value of FALSE.
9. Machine trips and speed drops below 2985 RPM.
10. Archive predicate changes to value of TRUE.
11. Archive is automatically created and sent to online server.

Disabling or re-enabling archive predicates only controls if the A6560R sends an archive to the online server. This does not stop the A6560R from recording measurements. In the above sequence, an analyst could extract a manual archive starting at the time when the archive predicate was initially false and ending at the time that the machine was at 3000 RPM.

6.10 Stop transient acquisition

An analyst can command the AMS 2600 to stop recording transient data.

Procedure

1. In the Online Watch tree structure, right-click on the AMS 2600 and select **Stop Transient Acquisition**.
   
   A caution window appears.

2. Click **Okay** to confirm.

   In the Transient Status tab, Current Acquisition State displays the message **Transient Acquisition has stopped**, and the AMS 2600 is no longer streaming data to the designated drive.

6.11 Remove an archive from the Transient Archive Status tab

In the Transient Archive Status tab, right-click on the archive and select **Acknowledge Transient Archive**.

**Note**

Removing archives does not delete archives from the online server; it only removes them from the list in the Transient Archive Status tab.
6.12 Change databases when moving the AMS 2600 to a new machine

Because the AMS 2600 is a portable system, ensure that measurements from the connected machine are stored in the correct database.

⚠️ CAUTION!

Change the database when you move the AMS 2600 from one monitoring rack or machine to another. Data from one machine could be stored in the database of another machine if this sequence is performed incorrectly.

⚠️ CAUTION!

Changing databases will reinitialize the Transient HDD, which eliminates all stored data. Extract any data before changing databases.

Prerequisites

Before disconnecting from the first machine, log in to AMS Machinery Manager.

From the Tools tab, click Setup/Communication and open RBM Network Administration.

Procedure

1. In the bottom center panel labeled Online Servers, double-click the server. The Online Server Setup dialog opens.
2. Click Stop Data Collection.
3. Disconnect the unit from the first machine.
4. Connect the unit to the second machine.
5. In Online Server Setup, click the Edit button next to Machinery Health Manager Database—not next to Active Units.
6. Select the second machine's database when prompted.
7. In Online Server Setup, click Start Data Collection.

The system will now store any measurements or archives in the second database.
7 Specifications

Topics covered in this chapter:
- AMS 6500 Machinery Health™ Monitor specifications
- AMS 2600 product specifications
- Environmental specifications
- A6560R Processor module LEDs
- A6510 Signal Input module LEDs

7.1 AMS 6500 Machinery Health™ Monitor specifications

Table 7-1: AMS 6500 Machinery Health™ Monitor (General)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog Channels</td>
<td>12 or 24 (1 or 2 A6510)</td>
</tr>
<tr>
<td>Tachometer Channels</td>
<td>2 or 4 (0.1-2 kHz, up to 60kHz divided to ≤2 kHz, (0.5 V to 24 V)</td>
</tr>
<tr>
<td>Relay Channels</td>
<td>2 or 4 (SPDT 24 V at 0.5 A dry contact)</td>
</tr>
<tr>
<td>Max. Frequency Range / Sampling Rate</td>
<td>40 kHz / 102,400 samples per second</td>
</tr>
<tr>
<td>ADC Resolution/Dynamic Range</td>
<td>24 bit / 100 dB conservatively measured</td>
</tr>
<tr>
<td>Lines of Resolution</td>
<td>100 up to 6400</td>
</tr>
<tr>
<td>Voltage Input Type / Impedance</td>
<td>±24V AC + DC / 1 MΩ (differential)</td>
</tr>
<tr>
<td>Sensor Power (ICP) / Impedance</td>
<td>4 mA at 22 V / 500 KΩ (single ended)</td>
</tr>
<tr>
<td>Channel Scan</td>
<td>2 Channel simultaneous</td>
</tr>
<tr>
<td>Channel Scan Rate</td>
<td>1 second; 2 CH, 400 LOR, 400 Hz, 1 average</td>
</tr>
<tr>
<td>Gross Scan</td>
<td>All channels continuous</td>
</tr>
<tr>
<td>Units</td>
<td>English, Metric, Hz, CPM, order</td>
</tr>
<tr>
<td>Scaling</td>
<td>Linear and Log</td>
</tr>
<tr>
<td>Windows</td>
<td>Hanning, Uniform</td>
</tr>
<tr>
<td>Averaging</td>
<td>Summation, Exponential, Synchronous Time</td>
</tr>
<tr>
<td>High frequency detection</td>
<td>PeakVue (Optional)</td>
</tr>
<tr>
<td>Hardware Communications</td>
<td>Modbus (Optional)</td>
</tr>
<tr>
<td>Vibration IEC60068-2-6 (operating)</td>
<td>5 g @ 57-500 Hz (3 axes)</td>
</tr>
<tr>
<td>Shock IEC60068-2-27 (operating)</td>
<td>30 g @11 ms (3 axes)</td>
</tr>
<tr>
<td>Shock IEC60068-2-27 (non-operating)</td>
<td>50 g @8 ms (3 axes)</td>
</tr>
</tbody>
</table>
### Table 7-2: AMS 6500 Machinery Health™ Monitor Transient, Digital Condition Recorder (Optional)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCR Analog Channels</td>
<td>12 or 24 (1 or 2 A6510-T)</td>
</tr>
<tr>
<td>DCR Tachometer Channels</td>
<td>2 or 4</td>
</tr>
<tr>
<td>DCR Maximum Frequency Range</td>
<td>DC to 2 kHz</td>
</tr>
<tr>
<td>DCR ADC Resolution/Dynamic Range</td>
<td>16 bit / &gt;80 dB</td>
</tr>
<tr>
<td>DCR Lines of Resolution</td>
<td>200 up to 51200</td>
</tr>
<tr>
<td>DCR (Digital Condition Recorder)</td>
<td>100 hours all channels / FIFO</td>
</tr>
<tr>
<td>DCR Channel Scan</td>
<td>All channels simultaneous</td>
</tr>
<tr>
<td>DCR Transient</td>
<td>up to 60 minutes from Alert/Scheduled/Demand</td>
</tr>
<tr>
<td>DCR Transient Modes (in AMS Machinery Manager)</td>
<td>Live viewing up to 11 channels</td>
</tr>
<tr>
<td>DCR Advanced Analysis Tools (in AMS Machinery Manager)</td>
<td>Replay with speed control</td>
</tr>
</tbody>
</table>

### 7.2 AMS 2600 product specifications

The AMS 2600 comes in a case with a retractable handle and two wheels for roll around transport.

#### Table 7-3: Physical dimensions—case

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>13.75 in.</td>
</tr>
<tr>
<td>Width</td>
<td>19.5 in.</td>
</tr>
<tr>
<td>Depth</td>
<td>24.5 in.</td>
</tr>
<tr>
<td>Weight (with case and unit)</td>
<td>53 lb.</td>
</tr>
</tbody>
</table>

#### Table 7-4: Physical dimensions—unit

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>20.5 in.</td>
</tr>
<tr>
<td>Width</td>
<td>8.25 in.</td>
</tr>
<tr>
<td>Depth</td>
<td>16 in.</td>
</tr>
<tr>
<td>Weight (unit alone)</td>
<td>30 lb.</td>
</tr>
</tbody>
</table>

### 7.3 Environmental specifications

#### Table 7-5: Environmental specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating temperature</td>
<td>-20–60°C (-4–140°F)</td>
</tr>
</tbody>
</table>
Table 7-5: Environmental specifications (continued)

| Relative humidity      | 5–95%, non-condensing |

7.4 A6560R Processor module LEDs

The A6560R Processor module has seven two-color LEDs. From top to bottom these are: Input Power, CPU Status, Transient Status, System Status, Server Connect, Modbus Connect, and Hard Drive Active.

Figure 7-1: A6560R Processor module LEDs

7.4.1 Input Power LED

The Input Power LED indicates the status of the power converters that distribute various voltages within the A6560R Processor card. A steady green color indicates that all power converters are within the proper voltage ranges, while a steady or blinking red condition indicates a power fault somewhere inside the A6560R Processor card.

7.4.2 CPU Status LED

The CPU Status LED indicates the status of the A6560R Processor card. The four status conditions are listed in Table 7-6 along with their assigned priorities.

More than one status condition may be active at one time. When this happens, the LED will indicate the active status condition with the highest priority. For example, if the module is both Uncalibrated (Priority 3) and is also currently In POST (Priority 1), the LED would indicate In POST.

Table 7-6: CPU status conditions

<table>
<thead>
<tr>
<th>LED Color</th>
<th>Status</th>
<th>Priority</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blinking Green</td>
<td>In POST</td>
<td>1</td>
<td>Typically only seen during system startup. Indicates that POST (Power On Self Test) is being performed, which involves Processor board resources.</td>
</tr>
<tr>
<td>Solid Red</td>
<td>Failure</td>
<td>2</td>
<td>Power supply POST failure, or other hardware failure on processor board.</td>
</tr>
</tbody>
</table>
7.4.3 Transient Status LED

The Transient Status LED indicates the status of the Transient system components. For the A6560R module, the LED is always off when transient capability is not enabled.

More than one status condition may be active at one time. When this happens, the LED will indicate the active status condition with the highest priority.

<table>
<thead>
<tr>
<th>LED Color</th>
<th>Status</th>
<th>Priority</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blinking Green</td>
<td>In POST</td>
<td>1</td>
<td>Typically only seen during system startup. Indicates that POST (Power On Self Test) is being performed, which involves Processor board resources.</td>
</tr>
<tr>
<td>Solid Red</td>
<td>Failure</td>
<td>2</td>
<td>Power supply POST failure, or other hardware failure on processor board.</td>
</tr>
<tr>
<td>Alternating Red/Green</td>
<td>Uncalibrated</td>
<td>3</td>
<td>One or more Transient channels are uncalibrated.</td>
</tr>
<tr>
<td>Solid Green</td>
<td>OK</td>
<td>4</td>
<td>Normal operation.</td>
</tr>
</tbody>
</table>

7.4.4 System Status LED

The System Status LED indicates the status of the overall system. It indicates the active status condition with the highest priority of all boards in the system. For example, if the Test Function generator on the A6560R Processor card is uncalibrated and the first MSIG module has a power fault, the LED will show a solid red color to indicate the MSIG module power fault, which is a “Failure” state.

When all the firmware components are operating as expected, this LED overlays a "heartbeat" pattern on top of the system status. The pattern occurs in a four-count cycle. The LED is pulsed off for the first and second counts, and then on for the third and fourth counts. In practice, it gives the appearance of a human heartbeat. If the pulse pattern stops, it indicates a firmware fault has occurred. Many times the system is capable of recovering. However, if the system cannot recover quickly, it will automatically reboot itself to clear the fault and will then resume monitoring.
7.4.5 Server Connect LED

The Server Connect LED indicates when AMS Machinery Manager software or the DHM diagnostic software are connected.

- A green color indicates that at least one AMS Machinery Manager software client is connected or that the DHM software is connected in the client mode.
- A red color indicates the DHM software is connected in the Single User mode. In this state, no other clients can connect.
- If the LED is off, it indicates that neither of these types of software clients are connected.

There is no indication of client data transfer, only the presence of at least one established connection.

7.4.6 Modbus Connect LED

The Modbus Connect LED indicates when a Modbus client, Web Browser, or Transient Live client are connected.

- A green color indicates that at least one of these types of clients has established a connection.
- If the LED is off, it indicates that none of these types of clients is connected.

The red color is not used with this LED.

There is no indication of client data transfer, only the presence of at least one established connection.

7.4.7 Hard Drive Active LED

The Hard Drive Active LED indicates when the onboard Transient hard drive is being accessed with read/write activity.

The green LED blinks on each time a read or write activity accesses the Transient hard drive. The more time the LED is green, the more hard drive activity.

This LED is always off if there is no Transient functionality installed in the system.

7.5 A6510 Signal Input module LEDs

Every A6510 Signal Input module has two, two-color LEDs. The top LED indicates the power converter status and the bottom LED indicates overall module status.
7.5.1 Power LED

The Power LED indicates the status of the MSIG module power converters.

A steady green color indicates that all voltage levels are OK, while a steady or blinking red condition indicates a power fault somewhere within the module.

7.5.2 Status LED

The Status LED indicates the overall status of the module. The four status conditions are listed in Table 7-8 along with their assigned priorities.

More than one status condition may be active at a time. When this happens, the LED will indicate the active status condition with the highest priority.

If the Status LED is off, the Signal Input module is being ignored by the A6560R Processor module. This is a special case which should not be encountered in practice. Modules are only ignored if the addition of the module would exceed the maximum channel count limits that the A6560R Processor module can support (24 analog, 4 Tach, 4 I/O). Channels are counted starting in the left-most.

Table 7-8: Signal Input Module status conditions

<table>
<thead>
<tr>
<th>LED Color</th>
<th>Status</th>
<th>Priority</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blinking Green</td>
<td>In POST</td>
<td>1</td>
<td>Typically only seen during system startup. Indicates that POST (Power On Self Test) is being performed, which involves Processor board resources.</td>
</tr>
<tr>
<td>Solid Red</td>
<td>Failure</td>
<td>2</td>
<td>Power supply POST failure, or other hardware failure on processor board.</td>
</tr>
<tr>
<td>Alternating Red/Green</td>
<td>Uncalibrated</td>
<td>3</td>
<td>One or more channels are uncalibrated.</td>
</tr>
<tr>
<td>Solid Green</td>
<td>OK</td>
<td>4</td>
<td>Normal operation.</td>
</tr>
</tbody>
</table>
8 System calibration

System calibration compensates for slight measurement variations that can occur across the temperature, voltage ranges, and variations in individual electronic components used by processing circuitry. Each A6560R is calibrated when it is assembled and verified at the factory. The calibration corrections are applied automatically during signal measurement and processing.

System calibration includes three procedures:

1. Calibrate the on-board signal generator, Test Signal Generator (TSG)
2. Calibrate the Gross Scan (GS).

The system should be recalibrated at least once a year, or when the processor or a signal input module has been replaced. To recalibrate an installed system, contact a local Emerson Product Support to schedule recalibration. Calibrations can be completed in less than an hour, but units cannot monitor equipment during that time.

8.1 System calibration overview

The Test Signal Generator (TSG) provides a precise output signal for input to each of the circuit calibrations.

During calibrations, the TSG output is routed internally in the A6560R CPU to processing electronics, and calibration tables for each circuit (shown in Calibration circuits input and output) are created and stored in non-volatile memory.

Optionally, the calibration tables can be uploaded to an Online Server. Contact Emerson Product Support for assistance with this operation.

Table 8-1: Calibration circuits input and output

<table>
<thead>
<tr>
<th>Calibration circuit</th>
<th>Input</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>TSG (Test Signal Generator)</td>
<td>(external) signal</td>
<td>TSG table (internal) TSG signal</td>
</tr>
<tr>
<td>GS (Gross Scan)</td>
<td>TSG signal</td>
<td>GS table</td>
</tr>
<tr>
<td>DSP (Digital Signal Processor)</td>
<td>TSG signal</td>
<td>DSP table</td>
</tr>
</tbody>
</table>
8.1.1 Test Signal Generator (TSG) calibration

All CPU boards provided by Emerson are shipped with a calibrated TSG circuit. If the CPU board is purchased as part of a system, the entire system is calibrated using the TSG circuit. Recalibrate the function generator every three years with a NIST traceable volt meter.

TSG calibration requires the following equipment:
- Digital Multi Meter (such as the HP 34401A)
- computer configured as online server
- special calibration utility program (DHM)
- cable that connects the computer to the 6560 Processor module Ethernet port
- cable that connects the computer to the Digital Multi Meter
- cable that connects the Digital Multi Meter to the test port on the unit

Emerson recommends that qualified Emerson Online Systems Engineers perform TSG calibration or recalibration.

8.1.2 Gross Scan (GS) calibration

GS calibration requirements:
- uses the A6560 CPU module TSG output signal.
- does not require that any wire harnesses be disconnected.
- is completed in about 10 minutes.
- does not require any special cables or test equipment.
- uses a special calibration utility program (DHM).

GS recalibration should be performed:
- annually.
- whenever an A6560R CPU module A6560R CPU module is replaced.
- whenever an A6560 CPU module is replaced.
- if the calibration table has a status of "Unknown".

Product Support personnel can guide a technician through GS calibration over the phone.

8.1.3 Digital Signal Processor (DSP) calibration

Digital Signal Processor (DSP) calibration requirements:
- uses a CPU board's TSG output signal.
- does not require that any wire harnesses be disconnected.
- is completed in about 30-40 minutes.
- does not require any special cables or test equipment.
- uses a special calibration utility program (DHM).
DSP recalibration should be performed:

- annually.
- whenever an A6510 Signal Input module is replaced.
- whenever an A6560R CPU module is replaced.
- if the calibration table has a status of "Unknown".

Product Support personnel can guide a technician through DSP calibration over the phone.
Appendix A
Data types

Topics covered in this appendix:

- Gross Scan analysis
- Spectral analysis
- Time Waveform analysis
- Non-Vibration unit analysis types
- Set DC offset

A.1 Gross Scan analysis

Includes Overall RMS Level, Sensor DC Bias, Gap, DC, or AC Process signals.

Note

Some DC Process Inputs could provide pk, pk-pk, or other Measurement Units.

Gross Scan parameters

All Gross Scan inputs must be DC in nature. Any Gross Scan input of a dynamic nature must be fed through the RMS/DC converter path. It is not technically valid to convert RMS values from an RMS/DC converter to pk or pk-pk Measurement Units unless the input is sinusoidal in nature. However, the AMS 6500 allows this. RMS values are multiplied by 1.414 or 2.828 to convert from RMS to pk and pk-pk, respectively.

A.1.1 Gross Scan units conversion

Table A-1: Gross Scan units conversion

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Input Unit</th>
<th>HW Int.</th>
<th>RMS/DC</th>
<th>Meas. Unit</th>
<th>Disp. Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC</td>
<td>V / E.U.</td>
<td>no</td>
<td>no</td>
<td>DC</td>
<td>E.U.</td>
</tr>
<tr>
<td>AC</td>
<td>V / E.U.</td>
<td>no</td>
<td>yes</td>
<td>RMS</td>
<td>E.U.</td>
</tr>
<tr>
<td>ACCEL</td>
<td>V / 32.2 ft/s</td>
<td>no</td>
<td>yes</td>
<td>RMS</td>
<td>g</td>
</tr>
<tr>
<td></td>
<td>V / 32.2 ft/s</td>
<td>yes</td>
<td>yes</td>
<td>RMS</td>
<td>in./s</td>
</tr>
<tr>
<td></td>
<td>V / 9.81 m/s</td>
<td>no</td>
<td>yes</td>
<td>RMS</td>
<td>g</td>
</tr>
<tr>
<td></td>
<td>V / 9.81 m/s</td>
<td>yes</td>
<td>yes</td>
<td>RMS</td>
<td>mm/s</td>
</tr>
</tbody>
</table>
### A.2 Spectral analysis

Spectral analysis includes:

- Total Energy
- Energy within a Frequency Range
- Synchronous Energy within a Frequency Range
- Non-Synchronous Energy within a Frequency Range
- HFD
- Relative Synchronous Harmonics
- Average
- Synchronous Peak

#### Note

Total Energy, Energy within a Frequency Range, Synchronous Energy within a Frequency Range, Non-Synchronous Energy within a Frequency Range, HFD, Relative Synchronous Harmonics, Average, Synchronous Peak. RMS, pk, pk-pk Measurement Units are valid and can be freely converted.

#### Spectral Scan parameters

All Spectral Scan parameters must be AC in nature. It is possible to convert some analysis type results between Measurement Unit types and Display Unit types.

### A.2.1 Spectral units conversion

#### Table A-2: Spectral units conversion

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Input Unit</th>
<th>HW Int.</th>
<th>SW Int.</th>
<th>SW Diff.</th>
<th>Disp. Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC</td>
<td>V / E.U.</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>E.U.</td>
</tr>
</tbody>
</table>
Table A-2: Spectral units conversion (continued)

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Input Unit</th>
<th>HW Int.</th>
<th>SW Int.</th>
<th>SW Diff.</th>
<th>Disp. Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACCEL</td>
<td>V / 32.2 ft/s</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>g</td>
</tr>
<tr>
<td></td>
<td>V / 32.2 ft/s</td>
<td>no</td>
<td>single</td>
<td>no</td>
<td>in./s</td>
</tr>
<tr>
<td></td>
<td>V / 32.2 ft/s</td>
<td>no</td>
<td>double</td>
<td>no</td>
<td>mil</td>
</tr>
<tr>
<td></td>
<td>V / 9.81 m/s</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>i/s</td>
</tr>
<tr>
<td></td>
<td>V / 9.81 m/s</td>
<td>no</td>
<td>no</td>
<td>single</td>
<td>mil</td>
</tr>
<tr>
<td></td>
<td>V / 9.81 m/s</td>
<td>no</td>
<td>no</td>
<td>single</td>
<td>g</td>
</tr>
<tr>
<td></td>
<td>V / 9.81 m/s</td>
<td>no</td>
<td>no</td>
<td>single</td>
<td>mm/s</td>
</tr>
<tr>
<td></td>
<td>V / 9.81 m/s</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>micron</td>
</tr>
<tr>
<td></td>
<td>V / 9.81 m/s</td>
<td>yes</td>
<td>no</td>
<td>single</td>
<td>micron</td>
</tr>
<tr>
<td></td>
<td>V / 9.81 m/s</td>
<td>yes</td>
<td>no</td>
<td>single</td>
<td>g</td>
</tr>
<tr>
<td>VEL</td>
<td>V / i/s</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>i/s</td>
</tr>
<tr>
<td></td>
<td>V / i/s</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>mil</td>
</tr>
<tr>
<td></td>
<td>V / i/s</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>mil</td>
</tr>
<tr>
<td></td>
<td>V / i/s</td>
<td>yes</td>
<td>yes</td>
<td>single</td>
<td>g</td>
</tr>
<tr>
<td></td>
<td>V / mm/s</td>
<td>no</td>
<td>no</td>
<td>single</td>
<td>mm/s</td>
</tr>
<tr>
<td></td>
<td>V / mm/s</td>
<td>no</td>
<td>no</td>
<td>single</td>
<td>micron</td>
</tr>
<tr>
<td></td>
<td>V / mm/s</td>
<td>no</td>
<td>no</td>
<td>single</td>
<td>micron</td>
</tr>
<tr>
<td></td>
<td>V / mm/s</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>g</td>
</tr>
<tr>
<td></td>
<td>V / mm/s</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>mm/s</td>
</tr>
<tr>
<td>DISP</td>
<td>V / mil</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>mil</td>
</tr>
<tr>
<td></td>
<td>V / mil</td>
<td>no</td>
<td>no</td>
<td>single</td>
<td>i/s</td>
</tr>
<tr>
<td></td>
<td>V / mil</td>
<td>no</td>
<td>no</td>
<td>double</td>
<td>g</td>
</tr>
<tr>
<td></td>
<td>V / micron</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>micron</td>
</tr>
<tr>
<td></td>
<td>V / micron</td>
<td>no</td>
<td>no</td>
<td>single</td>
<td>mm/s</td>
</tr>
<tr>
<td></td>
<td>V / micron</td>
<td>no</td>
<td>no</td>
<td>double</td>
<td>g</td>
</tr>
</tbody>
</table>

A.3 Time Waveform analysis

Time Waveform analysis includes:

- Variance
- True Peak
- Waveform pk-pk
Note
Measurement Unit type is specific to Analysis type.

A.3.1 Time Waveform units conversion

Table A-3: Time Waveform units conversion

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Input Unit</th>
<th>HW Int.</th>
<th>Disp. Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC</td>
<td>V / E.U.</td>
<td>no</td>
<td>E.U.</td>
</tr>
<tr>
<td>ACCEL</td>
<td>V / 32.2 ft/s</td>
<td>no</td>
<td>g, in./s</td>
</tr>
<tr>
<td></td>
<td>V / 32.2 ft/s</td>
<td>yes</td>
<td>g</td>
</tr>
<tr>
<td></td>
<td>V / 9.81 m/s</td>
<td>no</td>
<td>mm/s</td>
</tr>
<tr>
<td></td>
<td>V / 9.81 m/s</td>
<td>yes</td>
<td>mm/s</td>
</tr>
<tr>
<td>VEL</td>
<td>V / i/s</td>
<td>no</td>
<td>i/s</td>
</tr>
<tr>
<td></td>
<td>V / i/s</td>
<td>yes</td>
<td>mil</td>
</tr>
<tr>
<td></td>
<td>V / mm/s</td>
<td>no</td>
<td>mm/s</td>
</tr>
<tr>
<td></td>
<td>V / mm/s</td>
<td>yes</td>
<td>micron</td>
</tr>
<tr>
<td>DISP</td>
<td>V / mil</td>
<td>no</td>
<td>mil</td>
</tr>
<tr>
<td></td>
<td>V / micron</td>
<td>no</td>
<td>micron</td>
</tr>
</tbody>
</table>

A.4 Non-Vibration unit analysis types

Non-Vibration unit analysis includes:

- Peak to Average Ratio
- Average to Minimum Ratio
- Kurtosis
- Skewness
- Synchronous Phase

These analysis types produce non-unit ratios or specific unit types such as degrees of phase. Measurement Unit Type will not apply to these parameters.

A.5 Set DC offset

For thrust probes, the input channel is defined as a DC Process input. Set the DC offset so that the thrust reading may be zeroed.

Procedure

1. Use a DC voltmeter (or the DHM program) to measure the DC voltage as seen directly on the inputs.
2. In Online Configuration, right-click on a unit and select Configure Unit.
3. Right-click a channel icon and select Define.
4. Set the Signal Type to Process.
5. Select Properties and select the Sensor button.
6. Highlight New and select OK to define a new sensor.
7. Enter the voltage value into Offset Field.
Appendix B
Internal wiring of the AMS 2600

Topics covered in this appendix:

- Rear termination panel
- Internal wiring diagram — AMS 2600
- Terminal descriptors
- Rear terminal power connections
- AMS 2600 DIP switch settings

B.1 Rear termination panel

The rear termination panel plugs directly onto the backplane. This termination panel has connectors for sensor inputs, tachometer inputs, and discrete input/output relays into the 12-2-2 modules. All these connections are available through BNC connectors on the rear of the AMS 2600.
Table B-1: A6500-M-RTRM

<table>
<thead>
<tr>
<th>Termination panel</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Sensor inputs: MSIG1 (Ch1–12)</td>
</tr>
<tr>
<td>B</td>
<td>Sensor inputs: MSIG2 (Ch13–24)</td>
</tr>
<tr>
<td>C</td>
<td>Tach inputs(^{(1)}): MSIG1 (Ch1–2)</td>
</tr>
<tr>
<td>D</td>
<td>Tach inputs(^{(1)}): MSIG2 (Ch 3–4)</td>
</tr>
<tr>
<td>E</td>
<td>Relay I/O(^{(1)}): MSIG1 (I/O 1–2)</td>
</tr>
<tr>
<td>F</td>
<td>Relay I/O(^{(1)}): MSIG2 (I/O 3–4)</td>
</tr>
</tbody>
</table>
### Table B-1: A6500-M-RTRM (continued)

<table>
<thead>
<tr>
<th>Termination panel</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>G</td>
<td>DIP switches for routing buffered sensor/tach inputs from the A6500-P-RTRM side of the rack</td>
</tr>
<tr>
<td>H</td>
<td>DIP switches for configuring sensor power On or Off&lt;sup&gt;(2)&lt;/sup&gt; (SW1, SW2, SW3, SW5, SW6, and SW7)</td>
</tr>
<tr>
<td>I</td>
<td>Calibration test signal output port (SMB connector)</td>
</tr>
<tr>
<td>J</td>
<td>-24 V sensor power input for eddy current sensors</td>
</tr>
</tbody>
</table>

<sup>(1)</sup> For Tach and Relay channels, leave the sensor power DIP switches in the OFF position.
<sup>(2)</sup> SW4 and SW8 correspond to tach and relay channels, and are not used.

### Table B-2: A6500-M-BP backplane components

<table>
<thead>
<tr>
<th>Backplane</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>K</td>
<td>SysFail relay connector</td>
</tr>
<tr>
<td>L</td>
<td>DC Power input connector for Prediction Side</td>
</tr>
<tr>
<td>M</td>
<td>HUB network connector</td>
</tr>
<tr>
<td>N</td>
<td>Chassis Ground lug</td>
</tr>
<tr>
<td>O</td>
<td>NIC network connector</td>
</tr>
<tr>
<td>P</td>
<td>Power On LED</td>
</tr>
<tr>
<td>Q</td>
<td>+24 V Input LED</td>
</tr>
<tr>
<td>R</td>
<td>Status LED</td>
</tr>
</tbody>
</table>
B.3 Terminal descriptors

Each channel has five terminals. The first two are for the plus (+) and minus (-) signal inputs. If the associated DIP switch is set to ON, these terminals will also supply +24 V constant current accelerometer power.

The second two are for the -24 V power supply for eddy current probes. These terminals only supply power if an external -24 V power supply is connected to the J19 power input terminal at the edge of the termination panel.

Note
For the AMS 2600, this connection is not used and the -24 V power is available on the panel-mounted Phoenix connector on the rear of the case.

The last terminal for each channel is a chassis ground for connecting the sensor cable shield.
### Table B-3: Terminal descriptors for MSIG 1

<table>
<thead>
<tr>
<th>J1</th>
<th>J2</th>
<th>J3</th>
<th>J4</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH1</td>
<td>CH5</td>
<td>CH9</td>
<td>TAC1</td>
</tr>
<tr>
<td>SIG+1/+24 V</td>
<td>SIG+5/+24 V</td>
<td>SIG+9/+24 V</td>
<td>Tach+1</td>
</tr>
<tr>
<td>SIG-1/-24 V return</td>
<td>SIG-5/-24 V return</td>
<td>SIG-9/-24 V return</td>
<td>Tach-1</td>
</tr>
<tr>
<td>CH2</td>
<td>CH6</td>
<td>CH10</td>
<td>TAC2</td>
</tr>
<tr>
<td>SIG+2/+24 V</td>
<td>SIG+6/+24 V</td>
<td>SIG+10/+24 V</td>
<td>Tach+2</td>
</tr>
<tr>
<td>SIG-2/-24 V return</td>
<td>SIG-6/-24 V return</td>
<td>SIG-10/-24 V return</td>
<td>Tach-2</td>
</tr>
<tr>
<td>CH3</td>
<td>CH7</td>
<td>CH11</td>
<td>I/O1</td>
</tr>
<tr>
<td>SIG+3/+24 V</td>
<td>SIG+7/+24 V</td>
<td>SIG+11/+24 V</td>
<td>I/O+1</td>
</tr>
<tr>
<td>SIG-3/-24 V return</td>
<td>SIG-7/-24 V return</td>
<td>SIG-11/-24 V return</td>
<td>I/O-1</td>
</tr>
<tr>
<td>CH4</td>
<td>CH8</td>
<td>CH12</td>
<td>I/O2</td>
</tr>
<tr>
<td>SIG+4/+24 V</td>
<td>SIG+8/+24 V</td>
<td>SIG+12/+24 V</td>
<td>I/O+2</td>
</tr>
<tr>
<td>SIG-4/-24 V return</td>
<td>SIG-8/-24 V return</td>
<td>SIG-12/-24 V return</td>
<td>I/O-2</td>
</tr>
</tbody>
</table>

(1) -24 V terminals on I/O channels are not used for I/O connections.
<table>
<thead>
<tr>
<th>J5</th>
<th>J6</th>
<th>J7</th>
<th>J8</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH13</td>
<td>CH17</td>
<td>CH21</td>
<td>TACH3</td>
</tr>
<tr>
<td>SIG+13/+24 V</td>
<td>SIG+17/+24 V</td>
<td>SIG+21/+24 V</td>
<td>Tach+3</td>
</tr>
<tr>
<td>SIG-13/+24 V return</td>
<td>SIG-17/+24 V return</td>
<td>SIG-21/+24 V return</td>
<td>-24 V</td>
</tr>
<tr>
<td>-24 V</td>
<td>-24 V</td>
<td>-24 V</td>
<td></td>
</tr>
<tr>
<td>Gnd (-24 V return)</td>
<td>Gnd (-24 V return)</td>
<td>Gnd (-24 V return)</td>
<td>Gnd (-24 V return)</td>
</tr>
<tr>
<td>Shield</td>
<td>Shield</td>
<td>Shield</td>
<td>Shield</td>
</tr>
<tr>
<td>CH14</td>
<td>CH18</td>
<td>CH22</td>
<td>TACH4</td>
</tr>
<tr>
<td>SIG+14/+24 V</td>
<td>SIG+18/+24 V</td>
<td>SIG+22/+24 V</td>
<td>Tach+4</td>
</tr>
<tr>
<td>SIG-14/+24 V return</td>
<td>SIG-18/+24 V return</td>
<td>SIG-22/+24 V return</td>
<td>-24 V</td>
</tr>
<tr>
<td>-24 V</td>
<td>-24 V</td>
<td>-24 V</td>
<td></td>
</tr>
<tr>
<td>Gnd (-24 V return)</td>
<td>Gnd (-24 V return)</td>
<td>Gnd (-24 V return)</td>
<td>Gnd (-24 V return)</td>
</tr>
<tr>
<td>Shield</td>
<td>Shield</td>
<td>Shield</td>
<td>Shield</td>
</tr>
<tr>
<td>CH15</td>
<td>CH19</td>
<td>CH23</td>
<td>I/O3</td>
</tr>
<tr>
<td>SIG+15/+24 V</td>
<td>SIG+19/+24 V</td>
<td>SIG+23/+24 V</td>
<td>I/O+3</td>
</tr>
<tr>
<td>SIG-15/+24 V return</td>
<td>SIG-19/+24 V return</td>
<td>SIG-23/+24 V return</td>
<td>-24 V</td>
</tr>
<tr>
<td>-24 V</td>
<td>-24 V</td>
<td>-24 V</td>
<td></td>
</tr>
<tr>
<td>Gnd (-24 V return)</td>
<td>Gnd (-24 V return)</td>
<td>Gnd (-24 V return)</td>
<td>Gnd (-24 V return)</td>
</tr>
<tr>
<td>Shield</td>
<td>Shield</td>
<td>Shield</td>
<td>Shield</td>
</tr>
<tr>
<td>CH16</td>
<td>CH20</td>
<td>CH24</td>
<td>I/O4</td>
</tr>
<tr>
<td>SIG+16/+24 V</td>
<td>SIG+20/+24 V</td>
<td>SIG+24/+24 V</td>
<td>I/O+4</td>
</tr>
<tr>
<td>SIG-16/+24 V return</td>
<td>SIG-20/+24 V return</td>
<td>SIG-24/+24 V return</td>
<td>-24 V</td>
</tr>
<tr>
<td>-24 V</td>
<td>-24 V</td>
<td>-24 V</td>
<td></td>
</tr>
<tr>
<td>Gnd (-24 V return)</td>
<td>Gnd (-24 V return)</td>
<td>Gnd (-24 V return)</td>
<td>Gnd (-24 V return)</td>
</tr>
<tr>
<td>Shield</td>
<td>Shield</td>
<td>Shield</td>
<td>Shield</td>
</tr>
</tbody>
</table>
B.4 Rear terminal power connections

Figure B-2: Rear terminal power connections

B.5 AMS 2600 DIP switch settings

Each signal input channel has an associated DIP switch for connecting accelerometer power. For accelerometer channels that require power from the AMS 2600, set the associated DIP switch to the right, or On position. For sensor channels that do not require power, set the associated DIP switch to the left or Off position.

Note
For the Tach and Relay channels, the DIP switches must be in the Off position.
# Troubleshooting

During the lifetime of a AMS 6500 or AMS 2600 system, an analyst may need to troubleshoot the following situations:

## Table C-1: Troubleshooting

<table>
<thead>
<tr>
<th>Issue</th>
<th>Solution/reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>FTP server IP address changed.</td>
<td>Update boot flag settings.</td>
</tr>
</tbody>
</table>
| Measurements in Online Watch or Vibration Analysis seem incorrect or inconsistent. | If two instruments are showing different measurements for the same signal, it is likely that:  
  • Different units are being used by the two instruments.  
  • The monitoring rack output signal is not an exact replica of the input signal, rather it is a conditioned version.  
  • The monitoring rack output signal is a current-level signal (4-20 mA) not a voltage signal. |
| Online Watch/ Online Configuration shows status of Node (Unit) Down. | The following are possible solutions:  
  1. Restart CsiO_Server service.  
  2. Verify that IP addresses set in boot parameters match those set in AMS Machinery Manager.  
  3. With the unit connected to the network, ping the unit's IP address. If the ping is successful, there is probably a configuration mismatch between the unit and the server. Check the boot parameters. If the ping fails, there may be a physical error (bad Ethernet connection, gateway between two units, mismatching IP addresses). |
| System Status LED is red.                                            | Establish a Telnet connection to check unit status. If there was a POST failure, a flag will be set, and the title of the failure will be listed. Use these details to diagnose the issue. |
| Automatic archive was not created.                                   | Check the settings for the predicate. The predicate must change state from either FALSE or INDETERMINATE to TRUE. |
| Archive was truncated.                                                | An archive will have a status of Truncated if an analyst extracts a block of data across a gap in the time frame requested. |
| Unable to make changes to a database.                                | The system is in the process of storing an archive created with an earlier database configuration. Either wait for the archive to complete or cancel the archive. |
|                                                                      | The online server is attached to a different database. In RBM Network Administration, change the database associated with the online server. |
Index

A
active displacement sensor 24
adaptive automatic triggering 24
Alarm Limit (AL) Sets 41
ALS (Alarm Limit Sets) 41
Analysis Parameters (AP) Sets 41
anti-aliasing filter 22
APS (Analysis Parameters Sets) 41
auto-archive 46, 49
Axial Thrust predicate 15

B
BNC connectors 8, 26, 44, 69

C
cautions 4
cleaning 3, 4
console session 30
CPU Status LED 57

D
damage 3, 4
DAT recorder mode 11, 12
DHM 62
Digital Multi Meter 62
DIP switch 73

F
Format SSD 21

H
Hard Disk Drive (HDD) 10
Hard Drive Active LED 59
hazardous area 4
Hub port 14
HyperTerminal 27

I
Input Power LED 57
Internet Information Services (IIS) 33, 35

L
logical hierarchy
areas 41
components 41
data collection sets (DCS) 41
equipment 41
measurement points (MPs) 41

M
MHM Remote 33
Modbus 2, 3
Modbus Connect LED 59
Monitoring module 16
MtDbgMgr 33

N
Network Server 33
NIC port 14

O
Object Linking and Embedding for Process Control (OPC) 2, 3
on-board signal generator 61
Online Configuration 33
Online Server 33
Online Watch 33

P
passive magnetic sensor 24
PeakVue 2, 3
Phoenix connection 73
Power On Self Test (POST) 21, 57, 58
precautions 3, 4
predicates
auto-archive 41
collection 41
PuTTY 27

R
Radial Trip predicate 15
Root Mean Square (RMS) 17, 20, 23
Index

S
Serial port  14
Server Connect LED  59
signal inputs
  DC component  17
  dynamic AC  17
  process signals  17
  tachometer  17
SSD  20
SysFail relay  69
System Status LED  58

T
Telnet  27

Transient  20
Transient SSD  21
Transient Status LED  58
TTL pulse type sensor  24

V
Vibration Analysis  11, 12, 33

W
warnings  4
water 3, 4